
TOON BOOM ANIMATION INC.
4200 Saint-Laurent, Suite 1020
Montreal, Quebec, Canadá
H2W 2R2

+1 514 278 8666
contact@toonboom.com
toonboom.com

Toon Boom
Harmony Advanced V15.0
Guía de introducción 

Advanced



Avisos legales

Toon Boom Animation Inc. 
4200 Saint-Laurent, Suite 1020
Montreal, Quebec, Canadá
H2W 2R2

Tel: +1 514 278 8666
Fax: +1 514 278 2666

toonboom.com

Exención de responsabilidad

El contenido de esta guía está cubierto por una garantía limitada específica y por exclusiones y limitación de 
responsabilidad según el Contrato de licencia aplicable completado por los términos y condiciones especiales 
para el formato de archivo de Adobe®Flash® (SWF). Para obtener más información, consulte el Contrato de 
licencia, así como dichos términos y condiciones especiales.

El contenido de esta guía es propiedad de Toon Boom Animation Inc. y cuenta con derechos de propiedad 
intelectual.

Cualquier reproducción total o parcial está completamente prohibida.

Marcas comerciales

Harmony es una marca comercial de Toon Boom Animation Inc.

Fecha de publicación

06/03/2019

Copyright © 2017 Toon Boom Animation Inc., una empresa de Corus Entertainment Inc. Reservados todos los 
derechos.

1

Guía de introducción de Toon Boom Harmony 15 Advanced

http://www.toonboom.com/


Contenido

Contenido

Contenido 2

Capítulo 1: Introducción 6

Capítulo 2: Acerca de la pantalla de bienvenida 8

Capítulo 3: Creación de una escena 10

Capítulo 4: Introducción a la interfaz de usuario de Harmony 12

Vistas 14

Vista de cámara 14

Vista de dibujo 15

Vista de propiedades de la herramienta 16

Vista de color 17

Vista de línea de tiempo 17

Vista de carta de rodaje 18

Vista de librería 19

Interfaz de navegación 20

Interfaz táctil 22

Capítulo 5: Cómo dibujar 26

Ajuste de dibujos 27

Capítulo 6: Cómo pintar 34

Paletas de colores 35

Pintado 37

Cierre de huecos 38

Capítulo 7: Creación de una animación tradicional sin papel 40

Creación de un boceto de animación 40

Revisión de la animación 45

Limpieza 47

Capítulo 8: Aplicación de morphing a dibujos 52

Ajuste de la velocidad de morphing 55

Adición de sugerencias de morphing 55

2



Capítulo 9: Importación de imágenes 60

Vectorización de imágenes 64

Capítulo 10: Configuración de una escena 70

Adición de una cámara 70

Colocación de la cámara 70

Colocación de objetos 74

Cambio de posición del pivote 76

Capítulo 11: Animación de objetos y de la cámara 78

Animación de una capa 78

Animación de la cámara 81

Capítulo 12: Creación de un rig de un personaje Cut-out 86

Dibujo de las piezas 86

Adición de pegs 90

Creación de una jerarquía de capas 91

Peg maestro 94

Capítulo 13: Animación de un personaje Cut-out 96

Desplazamiento por las capas 102

Capítulo 14: Uso de deformadores 106

Deformador de huesos 106

Deformador de hueso para juego 107

Creación de deformadores 107

Visualización de deformadores 110

Modificación de las cadenas de deformación existentes 111

Animación con deformadores 114

Capítulo 15: Importación de sonido y sincronización de labios 118

Importación de sonido 118

Detección automática de sincronización de labios 119

Animación manual de sincronización de labios 122

Capítulo 16: Adición de efectos a una escena 124

3

Guía de introducción de Toon Boom Harmony 15 Advanced



Contenido

Acerca de los efectos 124

Adición de un efecto 125

Adición de un efecto con un mate 126

Animación de un efecto 129

Creación de un efecto basado en un personaje animado 131

Capítulo 17: Uso de guías de dibujo 134

Capítulo 18: Creación de un multiplano 140

Capítulo 19: Creación y uso de plantillas 144

Creación de una plantilla 144

Importación de una plantilla 145

Capítulo 20: Exportación de una película 148

Glosario 156

4



5

Guía de introducción de Toon Boom Harmony 15 Advanced



Capítulo 1: Introducción

Capítulo 1: Introducción
Harmony es un software de animación completo que permite crear todo tipo de proyectos de animación 
creativos. Incluye distintas herramientas y funciones.

En esta Guía de introducción, aprenderá las principales funciones y los conceptos básicos de Harmony 
Advanced, que le permitirán ponerse al día rápidamente. Consulte la documentación completa de Toon Boom 
Harmony disponible en línea en docs.toonboom.com para aprender acerca de todas las herramientas y 
opciones, así como sobre las técnicas avanzadas.
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Capítulo 2: Acerca de la pantalla de bienvenida
Al iniciar Toon Boom Harmony, aparece la pantalla de bienvenida. Si ya hay una escena abierta, puede mostrar 
la pantalla de bienvenida seleccionando Help > Show Welcome Screen (Ayuda > Mostrar pantalla de 
bienvenida).

NOTA

Si está utilizando Harmony Server en el modo de base de datos, la pantalla de bienvenida no se 
abrirá. En su lugar, se abrirá el selector de bases de datos y le permitirá abrir una escena de la base 
de datos.

La pantalla de bienvenida permite:

 1. Crear escenas

 2. Seleccionar la resolución de la escena

 3. Administrar los valores predeterminados de la resolución de la escena

 4. Abrir rápidamente escenas abiertas recientemente

 5. Examinar y abrir una escena de sus documentos

 6. Ver tutoriales en vídeo de Harmony

 7. Abrir la página de soporte en línea
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Capítulo 3: Creación de una escena

Capítulo 3: Creación de una escena
Todas las escenas creadas mediante Harmony Stand Alone son independientes y locales del equipo. Puede 
crear o abrir una escena utilizando la pantalla de bienvenida.

Si está usando Harmony Server, debe utilizar la aplicación Centro de control para crear escenas antes de que 
pueda abrirlas en Harmony. Las escenas de Harmony Server no se pueden crear directamente en Harmony.

Creación de una escena desde la pantalla de bienvenida

 1. En el campo Name (Nombre), escriba el nombre de la escena.

NOTA

El nombre de la escena no debe superar los 23 caracteres y no puede contener 
caracteres especiales, como *&^%!.

 2. Para decidir en qué directorio se va a crear la escena, haga clic en el botón Browse (Examinar) junto 
al campo Location (Ubicación).

 3. En el menú Camera Size (Tamaño de cámara), seleccione la resolución de la escena.

 4. Haga clic en Create Scene (Crear escena).

Se crea una nueva escena.
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Capítulo 4: Introducción a la interfaz de usuario de Harmony

Capítulo 4: Introducción a la interfaz de usuario de 
Harmony
El uso de Toon Boom Harmony será mucho más fácil si primero se familiariza con su interfaz de usuario. En este 
capítulo se proporciona una introducción básica a los elementos más importantes de la interfaz de usuario. A 
medida que avance por los capítulos, aprenderá información más detallada sobre cada uno de estos elementos.

Al iniciar Toon Boom Harmony por primera vez, se presenta el espacio de trabajo predeterminado. El espacio de 
trabajo está compuesto de barras de herramientas y paneles, denominados vistas, que permiten crear y editar 
la escena. El espacio de trabajo predeterminado contiene las barras de herramientas y vistas más utilizadas 
para la animación digital.

Adición de una vista al espacio de trabajo como una pestaña

 1. En la esquina superior derecha de una vista existente, haga clic en el botón Add View (Agregar 
vista) .
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 2. Seleccione la vista que desee en la lista.

La vista aparece como una nueva pestaña en la misma sección del espacio de trabajo:

NOTA

Algunas vistas, como las de cámara, perspectiva, librería y modelo, se pueden abrir en varias 
instancias. Por ejemplo, puede resultar útil si desea tener dos instancias de las vistas de cámara 
abiertas, cada una centrada en distintas áreas de la escena, para cambiar rápidamente entre 
los trabajos de estas dos áreas.

Adición de una vista al espacio de trabajo                                       como una ventana                 

 1. Abra el menú Windows (Ventanas).
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Capítulo 4: Introducción a la interfaz de usuario de Harmony

 2. Seleccione la vista que desee agregar.

La vista aparecerá como una nueva ventana sobre la ventana de la aplicación principal de Harmony.

Anclaje de una ventana de vista en el espacio de trabajo

 1. Arrastre la ventana por su pestaña y realice una de las siguientes acciones:

 l Coloque la ventana sobre otras pestañas existentes para agregarla al conjunto de 
pestañas.

 l Coloque la ventana por encima, por debajo o junto a una vista existente. Al acercarse al 
borde de una vista, aparece un rectángulo negro con fondo azul, que indica dónde se 
insertará la vista.

Vistas
Aquí se proporciona una breve introducción a cada una de las vistas más utilizadas en Harmony.

Vista de cámara
La vista de cámara es el centro de operaciones en Harmony. En esta vista puede dibujar, pintar, animar, 
configurar la escena, manipular objetos, abrir símbolos y previsualizar la animación.

La vista de cámara también tiene una barra de herramientas superior e inferior que puede utilizar para navegar 
en la vista, cambiar el modo de visualización o subir la jerarquía de símbolos.
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Vista de dibujo
En Harmony, puede dibujar tanto en la vista de dibujo como en la de cámara. Aunque las dos vistas son 
similares, hay algunas diferencias cuando se trata de dibujar.

En la vista de dibujo solo se muestra el dibujo seleccionado de forma predeterminada. Puede utilizar funciones 
como la mesa de luz para mostrar el dibujo actual de todas las capas habilitadas de la escena con colores 
lavados, o el papel cebolla para mostrar los dibujos anteriores y siguientes de la capa de dibujo seleccionada 
actualmente.
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Vista de propiedades de la herramienta
La vista de propiedades de la herramienta contiene las opciones y operaciones más comunes relacionadas con 
la herramienta seleccionada actualmente. Al seleccionar una herramienta en la barra de herramientas Tools 
(Herramientas), se actualiza la vista de propiedades de la herramienta.

Por ejemplo, si elige la herramienta Select (Seleccionar), la vista de propiedades de la herramienta mostrará las 
opciones y operaciones relacionadas con dicha herramienta, como Snap to Contour (Ajustar a contorno), Apply 
to All Drawings (Aplicar a todos los dibujos), Flip Horizontal (Voltear en horizontal) y Flatten (Acoplar).
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Vista de color
La vista de color es donde se crean colores y paletas y se importan paletas existentes en el proyecto. La vista de 
color también es necesaria para dibujar, pintar y crear estilos de color.

Vista de línea de tiempo
Para establecer el tiempo de la animación, trabajará principalmente con las vistas de línea de tiempo y de carta 
de rodaje. Es muy útil familiarizarse con la vista de línea de tiempo, su funcionamiento y su interfaz.

La vista de línea de tiempo es la vista principal utilizada al ajustar el tiempo de los dibujos, agregar fotogramas 
clave y ordenar capas. La vista de línea de tiempo muestra capas, efectos, sonidos, valores de fotogramas clave, 
longitud de escena, nombres de capas, dibujos, fotogramas clave, tiempo y fotogramas.
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La vista de línea de tiempo permite leer el tiempo de izquierda a derecha. Representa los elementos de la 
escena en su forma más simple. También puede ver las capas y sus nombres, así como la exposición del dibujo. El 
nombre del dibujo se muestra al colocar el puntero sobre la exposición del dibujo.

Vista de carta de rodaje
La vista de carta de rodaje permite leer el tiempo verticalmente mostrándolo en una cuadrícula, con cada capa 
de dibujo representada por una columna, cada fotograma de la escena representado por una fila y cada dibujo 
expuesto mostrado por su nombre en las celdas. Se pretende que funcione como una carta de exposición de 
animación tradicional.

Con el panel de funciones, también puede ver las funciones y los fotogramas clave de las rutas de movimiento 
de la columna seleccionada, con el valor de esas funciones para cada fotograma que se muestra en las celdas.

A diferencia de la vista de línea de tiempo, la vista de carta de rodaje no muestra pegs, efectos o jerarquía de 
capas. Por lo tanto, se optimiza para una animación tradicional y sin papel, mientras que la vista de línea de 
tiempo se optimiza para una animación digital o Cut-out.

18



Vista de librería
La vista de librería se utiliza para almacenar elementos como animaciones, dibujos, fondos y modelos de 
personajes para volver a utilizarlos en distintas escenas y proyectos. También puede utilizar la vista de librería 
para crear y almacenar símbolos, así como para almacenar e importar imágenes y archivos de sonido.

Para reutilizar elementos de una escena en otras escenas, debe crear una plantilla para poder importarla en 
distintas escenas. Las plantillas pueden contener cualquier elemento, desde un solo dibujo hasta una estructura 
de escena completa. Puede crear una plantilla en una escena y copiar los elementos que desee tener en la 
plantilla en una librería. La plantilla resultante se estructura como una miniescena que solo contiene los 
elementos que copió en ella. Una plantilla no tiene ninguna dependencia en la escena en la que se creó 
originalmente. Por lo tanto, se puede importar de forma segura en cualquier otra escena.

Además, el panel Drawing Substitution (Sustitución de dibujo) de la vista de librería permite cambiar 
rápidamente la exposición del fotograma actual a uno de los dibujos existentes en una capa. Esto es 
especialmente útil para la animación de las bocas, manos, párpados y otras partes del cuerpo de un personaje 
Cut-out que suelen contener varios dibujos donde elegir.
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Interfaz de navegación
Toon Boom Harmony permite acercar, alejar, rotar, panear y restablecer vistas para navegar fácilmente por la 
interfaz.

Los comandos de navegación de la tabla que se muestra a continuación se pueden utilizar en las siguientes 
vistas, con algunas excepciones:

 l Cámara

 l Dibujo

 l Perspectiva

 l Línea de tiempo

 l Carta de rodaje

 l Función

 l Lateral y superior

 l Modelo

Comando Acción Métodos de acceso

Zoom In 
(Acercar)

Acerca la vista. 

View > Zoom In (Ver > Acercar)

Pulse 2

Gire la rueda del ratón hacia arriba 
(excepto en las vistas de línea de 
tiempo y de carta de rodaje).

Zoom Out 
(Alejar)

Aleja la vista.
View > Zoom Out (Ver > Alejar)

Pulse 1
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Gire la rueda del ratón hacia abajo 
(excepto en las vistas de línea de 
tiempo y de carta de rodaje).

Zoom In or Out 
(Acercar o alejar)

Acerca o aleja la vista.

Gire la rueda central del ratón hacia 
arriba o hacia abajo.

Mantenga pulsada la barra espaciadora 
y la rueda central del ratón mientras 
arrastra el ratón hacia arriba o hacia 
abajo.

Pan (Panear) Mueve la vista horizontal o verticalmente.
Mantenga pulsada la barra espaciadora 
y arrastre en la dirección que desee 
panear la vista.

Reset Pan 
(Restablecer 
paneo)

Restablece el paneo de vista a su posición predeterminada.

View > Reset Pan (Ver > Restablecer 
paneo)

Pulse Mayús + N

Reset View 
(Restablecer 
vista)

Restablece la vista a su posición predeterminada.

View > Reset View (Ver > Restablecer 
vista)

Pulse Mayús + M

Reset Rotation 
(Restablecer 
rotación)

Restablece la rotación de vista a su posición 
predeterminada.

View > Reset Rotation (Ver > 
Restablecer rotación)

Pulse Mayús + X

Reset Zoom 
(Restablecer 
zoom)

Restablece el zoom de vista a su posición predeterminada.
View > Reset Zoom (Ver > Restablecer 
zoom)

Rotate View 
(Rotar vista)

Rota la vista.
Pulse Ctrl+Alt (Windows/Linux) o 
Ctrl+⌘  (macOS) y arrastre en la 
dirección que desee rotar la vista.

Rotate 30 CW 
(Rotar 30 
derecha)

Rota la vista de cámara 30 grados a la derecha, como una 
mesa de animación.

View > Rotate View CW (Ver > Rotar 
vista a la derecha)

Rotate 30 CCW 
(Rotar 30 
izquierda)

Rota la vista de cámara 30 grados a la izquierda, como una 
mesa de animación.

View > Rotate View CCW (Ver > Rotar 
vista a la izquierda)

Toggle Quick 
Close-up 
(Alternar primer 
plano rápido)

Multiplica al instante el factor de zoom de la vista por 4. Por 
ejemplo, si el factor de zoom de la vista de cámara se 
encuentra al 100 %, esto hará que alterne entre 400 % y 
100 %.

Mayús+Z

Toggle Full 
Screen (Alternar 
pantalla 
completa)

Pasa por los siguientes modos de visualización:

 l Normal Full-Screen (Pantalla completa normal): La 
ventana principal de la aplicación se convierte en 
pantalla completa.

 l View Full-Screen (Ver pantalla completa): La vista 

View > Toggle Full Screen (Ver > 
Alternar pantalla completa)

Pulse Ctrl + F (Windows/Linux) o ⌘  + 
F (macOS)
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Capítulo 4: Introducción a la interfaz de usuario de Harmony

seleccionada se convierte en pantalla completa y 
todas las demás vistas se contraen.

 l Normal: La ventana principal de la aplicación se 
restaura a su tamaño original y las vistas contraídas 
se expanden.

Interfaz táctil
Si está trabajando con una pantalla táctil, un trackpad o una tableta que admita función táctil, también puede 
utilizar los gestos de dos dedos estándar para zoom, rotación y paneo en las vistas de cámara y dibujo. Para 
poder hacer esto, primero debe habilitar la preferencia Support Gestures (Soporte de gestos).

Habilitación del soporte de gestos

 1. En el menú superior, vaya a Edit > Preferences (Editar > Preferencias) (Windows/Linux) o Harmony 
> Preferences (Harmony > Preferencias) (Mac OS X).

 2. Abra la pestaña General.

 3. En la sección Touch Interface (Interfaz táctil), active la casilla de verificación Support Gestures 
(Soporte de gestos).

 4. Haga clic en OK (Aceptar).

 5. Reinicie Harmony.

Ahora puede manipular las vistas de cámara y de dibujo arrastrando dos dedos sobre la interfaz 
táctil.

Uso de gestos

 1. En la vista de cámara o de dibujo, presione con dos dedos situados a una distancia corta entre sí.

 2. Realice una de las siguientes acciones:

 l Para panear la vista, arrastre los dos dedos en cualquier dirección, manteniéndolos a la 
misma distancia uno del otro.
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 l Para acercar el zoom, arrastre los dos dedos separando uno del otro.

 l Para alejar el zoom, arrastre los dos dedos acercando uno al otro.

 l Para rotar, arrastre los dos dedos haciendo una curva para que giren en la misma 
dirección.
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Capítulo 5: Cómo dibujar
Una vez iniciado Toon Boom Harmony, puede comenzar a dibujar inmediatamente utilizando la capa de dibujo 
predeterminada.

Cómo dibujar

 1. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Pencil (Lápiz)  o 
pulse Alt + /.

 2. En la vista de línea de tiempo o de carta de rodaje, haga clic en la primera celda de la capa de dibujo.

 3. Para seleccionar un color, haga clic en el color que desee utilizar en la vista de color. Para obtener 
más información sobre la creación y edición de colores, consulte Creación o edición de muestras de 
colores en la página 36.

 4. En la vista de dibujo o de cámara, comience a dibujar.
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Ajuste de dibujos
Harmony ofrece distintas maneras de ajustar los dibujos. Puede deshacer la última línea vectorial transparente, 
borrar partes de un dibujo, mover, transformar o eliminar líneas vectoriales transparentes, y modificar los 
puntos y las curvas de las líneas de lápiz.

Cómo deshacer la última línea vectorial transparente

 1. Realice una de las siguientes acciones:

 l En el menú superior, seleccione Edit > Undo (Editar > Deshacer).

 l Pulse Ctrl + Z (Windows/Linux) o ⌘  + Z (macOS).

Cómo borrar

 1. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Eraser (Borrador)  o 
pulse Alt + E.

 2. En la vista de dibujo o de cámara, dibuje una línea vectorial transparente sobre las partes del dibujo 
que desee borrar.

Edición de las líneas vectoriales transparentes del dibujo

 1. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Select (Seleccionar)  
o pulse Alt + S.

 2. En la vista de cámara o de dibujo, seleccione las líneas vectoriales transparentes que desee editar 
realizando una de las siguientes acciones:
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Capítulo 5: Cómo dibujar

 l Haga clic en una línea vectorial transparente para seleccionarla.

 l Mantenga pulsada la tecla Mayús mientras hace clic en una línea vectorial 
transparente para agregarla a la selección.

 l Dibuje un lazo alrededor de las líneas vectoriales transparentes del dibujo para 
seleccionarlas simultáneamente.

 3. Realice una de las siguientes acciones para editar la selección:

 l Para cambiar la posición, haga clic en el objeto de dibujo seleccionado y arrastre la 
selección a una nueva área.

NOTA

También puede realizar un desplazamiento pequeño de la selección con 
las teclas de flecha y, para realizar un desplazamiento rápido, mantenga 
pulsada la tecla Mayús y pulse las teclas de flecha.

 l Para rotar, agarre el controlador de la caja de selección y rótelo.
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 l Para escalar, tire o empuje en el punto de control superior, lateral, inferior o de esquina. 
Mantenga pulsada la tecla Mayús para bloquear la proporción de la selección.

 l Para sesgar, arrastre hacia los lados o arriba y abajo los lados o los segmentos superior 
e inferior, entre los puntos de control.

 l Para eliminar, pulse Supr (Windows/Linux) o retroceso (macOS).

Edición de las líneas

 1. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Contour Editor (Editor 
de contorno)  o pulse Alt + Q.

 2. En la vista de dibujo o de cámara, haga clic en la línea para mostrar los puntos de control.
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 3. Seleccione uno o varios puntos realizando una de las siguientes acciones:

 l Haga clic en un punto para seleccionarlo.

 l Mantenga pulsada la tecla Mayús mientras hace clic en un punto para agregarlo a la selección.

 l Dibuje un lazo alrededor de varios puntos para seleccionarlos simultáneamente.

 4. Realice una de las siguientes acciones para editar la forma:

 l Tire del controlador de curva Bézier para cambiar la dirección de la curva. Ambos 
controladores del punto rotarán simultáneamente, afectando a la curva en ambos 
lados del punto.

 l Mantenga pulsada la tecla Alt y tire de uno de los controladores de curva Bézier para 
rotarlo independientemente del otro.
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 l Haga clic y arrastre un punto para moverlo.

 l Tire directamente de la línea para deformar la forma.

 l Mantenga pulsada la tecla Mayús mientras tira de la línea para deformar la línea entre 
dos puntos.

 l Si un punto de anclaje no tiene controladores de curva Bézier visibles, mantenga 
pulsada la tecla Alt y arrastre desde el punto para crear sus controladores de curva 
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Bézier.

 l Para agregar puntos de control, pulse Ctrl (Windows/Linux) o ⌘  (macOS) y haga clic 
en la línea.

 l Para eliminar puntos de control, seleccione el punto de control y pulse Supr 
(Windows/Linux) o retroceso (macOS).
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Capítulo 6: Cómo pintar

Toon Boom Harmony incluye algunas funciones de pintura muy útiles para agregar color a los dibujos. Mientras 
que otro software solo permite que los usuarios trabajen con muestras de color de una en una, la pintura en 
Harmony se realiza con paletas que contienen varias muestras de color que se pueden almacenar y reutilizar 
según sea necesario.

En la vista de color, seleccione una muestra de color distinta para cada color que desee pintar en el dibujo. 
Puede agregar todas las muestras de color que desee. También puede cambiar el nombre a las existentes y 
modificarlas.

Cuando modifique el color de una muestra existente, se actualizarán automáticamente todas las zonas pintadas 
con esta muestra en toda la escena. La muestra de color tiene un número de ID exclusivo que la asocia con las 
zonas pintadas. De este modo, puede cambiar el aspecto del personaje en cualquier momento sin necesidad de 
volver a pintarlo.
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Otra ventaja de este sistema es que puede crear paletas completas para distintas situaciones de luz. Por 
ejemplo, además de la paleta habitual para un personaje, también puede tener una para ese personaje en la 
lluvia con colores más apagados y menos vivos que los colores de días secos, o incluso otra para una escena de 
noche. De este modo, el uso de paletas vinculadas a un personaje permite cambiar el color al instante para 
ajustarse al clima y al ambiente de la escena sin necesidad de volver a pintar cada elemento.

Paletas de colores
En animación se utilizan colores específicos para pintar cada parte de cada personaje. Con el fin de mantener 
una coherencia absoluta, se debe crear una paleta de colores base para cada personaje, prop y efecto de la 
producción. A esto se le denomina paleta maestra.

Las paletas maestras contienen una muestra de color para cada área que se deba colorear. Cada muestra 
almacena un color de niveles precisos de rojo, verde, azul y opacidad (a este último se le denomina alfa).

El uso de una paleta de colores maestra tiene muchas ventajas, entre otras:

 l Cada personaje conserva permanentemente sus colores específicos.

 l No puede usar por error un color que no esté en la paleta maestra.

 l Estandarización y uniformidad del color durante la producción.

 l Varios artistas pueden usar la misma paleta de colores y generar los mismos resultados.

Harmony utiliza paletas para mantener todos los colores necesarios para pintar los elementos, lo que permite un 
control y uniformidad totales del proceso de pintado.

Una paleta se crea asignando un conjunto de colores a cada personaje, prop o efecto. Creará una nueva paleta y 
agregará un nuevo color, conocido como muestra de color, para cada zona del personaje, como la piel, el pelo, la 
lengua, la camiseta, los pantalones, etc.

Creación de una nueva paleta

 1. En el menú de vista de color, seleccione Palettes > New (Paletas > Nueva) o haga clic en el botón 
New Palette (Nueva paleta) .

Se abre el cuadro de diálogo Create Palette (Crear paleta).

 2. Introduzca el nombre de la paleta según el modelo.

 3. Haga clic en OK (Aceptar).

La paleta aparece en la lista de paletas.
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Creación o edición de muestras de colores

 1. Si desea crear una nueva muestra de color, haga clic en el botón Add Colour (Agregar color)  en la 
vista de color. Si desea editar una muestra de color existente, seleccione el color en la vista de color.

 2. Realice una de las siguientes acciones para editar la muestra de color:

 l En el menú de vista de color, seleccione Colours > Edit (Colores > Editar).

 l Haga doble clic en la muestra de color.

Se abre la ventana Coulour Picker (Selector de color).

 3. Para definir el color, realice una de las siguientes acciones:

 l Seleccione Red (Rojo), Green (Verde), Blue (Azul), Hue (Matiz), Saturation (Saturación) 
o Value (Valor) para cambiar el espectro del círculo cromático y, a continuación, haga 
clic en el color que desee en el círculo cromático.

 l Introduzca los valores de matiz, saturación, valor, rojo, verde y azul de forma manual en 
los campos correspondientes. Todos los valores oscilan entre 0 y 255.
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NOTA

Si cambia una muestra de color después de haber dibujado o pintado con él áreas de un dibujo, 
todas las áreas pintadas con este color en los dibujos vectoriales se actualizarán al nuevo color.

Pintado
Puede pintar las zonas cerradas de los dibujos con la herramienta Paint (Pintar).

Cómo pintar dibujos

 1. En la vista de línea de tiempo o de carta de rodaje, seleccione el dibujo que desea pintar.

 2. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Paint (Pintar)  o 
pulse Alt + I.

 3. En la vista de color, seleccione la paleta del personaje.

 4. Seleccione un color de la paleta.

 5. En la vista de dibujo o de cámara, comience a pintar el dibujo con los colores.
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NOTA

Al abrir una escena, las paletas de esta no se cargarán inmediatamente en la vista de color. 
Primero debe seleccionar un dibujo.

Cierre de huecos
Al pintar, puede encontrar que algunas áreas del dibujo no estaban completamente cerradas debido a 
pequeños huecos en los contornos, lo que impide que la herramienta Paint (Pintar) rellene el área, ya que solo 
rellena formas cerradas. Para cerrar la zona, puede dibujar una línea sobre el hueco con la herramienta Brush 
(Pincel) o Pencil (Lápiz). Sin embargo, solo es posible cerrar el hueco agregando encima una línea invisible, que 
la herramienta Paint (Pintar) considerará como una línea normal. En Harmony, las líneas invisibles utilizadas 
para definir las áreas que se deben colorear se denominan líneas vectoriales transparentes.

La herramienta Close Gap (Cerrar hueco) permite cerrar pequeños huecos en el contorno de un dibujo 
dibujando al instante una línea vectorial transparente para rellenar el hueco. A diferencia de la herramienta 
Stroke (Línea vectorial transparente), con la herramienta Close Gap (Cerrar hueco) no tiene que dibujar con 
precisión. Solo tiene que dibujar una línea vectorial transparente básica junto al hueco para que se cree 
automáticamente una línea vectorial transparente recta que conecte directamente un extremo del hueco al otro.
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Uso de la herramienta Close Gap (Cerrar hueco)

 1. Antes de trabajar con líneas vectoriales transparentes, se recomienda habilitar la opción Show 
Strokes (Mostrar líneas vectoriales transparentes), de modo que pueda verlas en la vista de dibujo o 
de cámara. Puede habilitar la opción Show Strokes (Mostrar líneas vectoriales transparentes) 
realizando una de las siguientes acciones:

 l En el menú superior, seleccione View > Show > Show Strokes (Ver > Mostrar > 
Mostrar líneas vectoriales transparentes).

 l Pulse K.

 2. Realice una de las siguientes acciones:

 l En la barra de herramientas Tools (Herramientas), seleccione la herramienta Close Gap 
(Cerrar hueco)  .

 l En el menú superior, seleccione Drawing > Drawing Tools > Close Gap (Dibujo > 
Herramientas de dibujo > Cerrar hueco).

 l Pulse Alt + C.

 3. En la vista de cámara o de dibujo, trace una línea invisible cerca del hueco que se va a cerrar.

El hueco se cierra automáticamente.

NOTA

La herramienta Paint (Pintar) también incluye una opción Close Gap (Cerrar hueco), que se puede 
habilitar en la vista de propiedades de la herramienta. Cuando esté habilitada, Harmony 
automáticamente intentará encontrar y cerrar pequeños huecos cuando intente rellenar una forma 
que no esté cerrada.
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Capítulo 7: Creación de una animación tradicional sin 
papel

Creación de un boceto de animación
El primer paso para crear una animación sin papel es la creación de un boceto, que es el esqueleto de la 
animación. Por lo general, empezaría animando la parte más importante de la acción de un personaje. Por 
ejemplo, para animar un ciclo de andar, comenzará por el movimiento del torso y de las piernas. Después se 
puede agregar una animación secundaria como la cabeza, los brazos y la ropa.

Para que la animación sea satisfactoria, comience animando la acción principal con esbozos básicos y rápidos y, 
a continuación, agregue los detalles cuando esté satisfecho con el movimiento. Si comienza a animar todos los 
detalles inmediatamente, perderá mucho tiempo en caso de tener que realizar correcciones, y es probable que 
la animación parezca rígida.

Creación de un boceto de animación

 1. En la vista de línea de tiempo, haga clic en Show All Thumbnails (Mostrar todas las imágenes 
miniatura)  para habilitar el modo Thumbnail (Imagen miniatura).

 2. Pulse Ctrl + U (Windows/Linux) o ⌘  + U (macOS) para abrir el cuadro de diálogo Preferences 
(Preferencias).

 3. Seleccione la pestaña Exposure Sheet (Carta de exposición).
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 4. Seleccione la opción Use Current Frame as Drawing Name (Usar fotograma actual como nombre de 
dibujo). Cuando esta preferencia esté habilitada, los dibujos nuevos se nombrarán con el número de 
fotograma en el que se crearon.

 5. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Brush (Pincel)  o 
pulse Alt + B.

 6. En la vista de color, seleccione un color para el pincel. Es una buena idea elegir un color claro para el 
boceto de animación. Esto facilitará el proceso de clean up, ya que las líneas oscuras y limpias 
contrastarán con las líneas esbozadas claras.

 7. En la vista de línea de tiempo o de carta de rodaje, seleccione la celda en la que desea que aparezca 
el primer dibujo.

 8. En la vista de cámara o de dibujo, dibuje el primer dibujo clave.

En cuanto dibuje la primera línea vectorial transparente, se creará automáticamente un dibujo en la 
celda seleccionada.

 9. Aumente el nivel de zoom de la vista de línea de tiempo hasta que vea las imágenes miniatura 
dentro de las celdas realizando una de las siguientes acciones:
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 l Arrastre el control Timeline Zoom (Zoom de línea de tiempo) hacia la derecha.

 l Haga clic en la pestaña de la vista de línea de tiempo y pulse 2 de forma reiterada.

 l Mueva el cursor del ratón en la vista de línea de tiempo, mantenga pulsada la tecla Ctrl 
(Windows/Linux) o ⌘  (macOS) y gire la rueda del ratón hacia arriba.

 10. Con la primera celda aún seleccionada, realice una de las siguientes acciones para marcar el dibujo 
como dibujo clave. Esto le ayudará a mantener el orden.

 l Habilite la barra de herramientas Mark Drawing (Marcar dibujo) seleccionando 
Windows > Toolbar > Mark Drawing (Ventanas > Barra de herramientas > Marcar 
dibujo) en el menú superior y, a continuación, haga clic en el botón Mark Selected 
Drawings as Key (Marcar dibujo como dibujo clave) .

 l Habilite la barra de herramientas Xsheet (Carta de rodaje) centrándose en la carta de 
rodaje y seleccione Windows > Toolbar > Xsheet (Ventanas > Barra de herramientas 
> Carta de rodaje) en el menú superior. A continuación, haga clic en el botón Mark as 
Key Drawing (Marcar como dibujo clave) .

 l En el menú de la vista de línea de tiempo, seleccione Drawings > Mark Drawing As > 
Key Drawing (Dibujos > Marcar dibujo como > Dibujo clave).

 

 11. En la vista de línea de tiempo o de carta de rodaje, seleccione la celda en la que desea que aparezca 
el próximo dibujo clave.

 12. En la barra de herramientas Tools (Herramientas), haga clic en el botón Onion Skin (Papel cebolla) 
. Esto mostrará los dibujos anteriores y siguientes en un color claro en la vista de cámara o dibujo, 

detrás del dibujo actual, para que pueda utilizarlos como referencias para realizar nuevos dibujos con 
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precisión. Esta opción puede ser útil para dibujar poses de descomposición entre dos poses clave, o 
para agregar un dibujo intercalado entre otros dos dibujos.

 13. Asegúrese de que el papel cebolla muestre el primer dibujo clave para que pueda basar el segundo 
dibujo clave en él. Para llevarlo a cabo, realice una de las siguientes acciones:

 l En la vista de línea de tiempo, arrastre los marcadores azules de papel cebolla para 
ampliar el número de dibujos anteriores y siguientes para que se visualicen como papel 
cebolla.

 l En la barra de herramientas Camera View (Vista de cámara) o Drawing View (Vista de 
dibujo), utilice los botones Onion Skin Add One Previous Drawing (Agregar un dibujo 
anterior de papel cebolla) , Onion Skin Reduce One Previous Drawing (Reducir un 
dibujo anterior de papel cebolla) , Onion Skin Reduce One Next Drawing (Reducir 
un dibujo siguiente de papel cebolla)  y Onion Skin Add One Next Drawing 
(Agregar un dibujo siguiente de papel cebolla)  para ajustar la extensión del papel 
cebolla fotograma a fotograma.

NOTA

En la vista de dibujo, puede utilizar la barra de herramientas Onion Skin (Papel 
cebolla) para que el papel cebolla solo muestre tipos específicos de dibujos, como 
dibujos clave o descomposiciones. Tenga en cuenta que esto no funciona en la 
vista de cámara.

 14. Cree un nuevo dibujo vacío mediante una de las siguientes acciones:

 l En la barra de herramientas Timeline (Línea de tiempo) o Xsheet (Carta de rodaje), 
haga clic en el botón Create Empty Drawing (Crear dibujo vacío) .

 l Pulse Alt + Mayús + R.

 15. En la vista de cámara o de dibujo, dibuje el segundo dibujo clave.
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 16. En la vista de carta de rodaje o de línea de tiempo, identifique el dibujo como dibujo clave.

 17. En la vista de línea de tiempo o de carta de rodaje, seleccione una celda entre los dos dibujos clave.

 18. Cree un nuevo dibujo vacío mediante una de las siguientes acciones:

 l En la barra de herramientas Timeline (Línea de tiempo) o Xsheet (Carta de rodaje), 
haga clic en el botón Create Empty Drawing (Crear dibujo vacío) .

 l Pulse Alt + Mayús + R.

 19. En la vista de cámara o de dibujo, dibuje la nueva pose.

 20. En la vista de línea de tiempo o de carta de rodaje, seleccione una nueva celda y repita los pasos 
anteriores para cada nuevo dibujo.
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NOTA

Al trabajar con capas de superposición en la vista de cámara, puede habilitar la opción Current 
Drawing on Top (Dibujo actual encima)  para hacer que la capa en la que está trabajando 
aparezca sobre las otras capas.

Revisión de la animación
Al realizar un flipping por los dibujos se puede ver si los dibujos en los que se está trabajando conectan bien 
entre sí y crean la ilusión de movimiento adecuada. Puede desplazarse rápidamente por los dibujos con los 
atajos de teclado para ir al dibujo anterior e ir al dibujo siguiente, o con la barra de herramientas Easy Flipping 
(Flipping sencillo).

Desplazamiento por los dibujos

 1. En la vista de línea de tiempo o de carta de rodaje, seleccione el dibujo desde donde desee 
desplazarse.

 2. Realice una de las siguientes acciones:

 l Pulse F para ir al dibujo anterior.

 l Pulse G para ir al dibujo siguiente.

 3. Pulse ambos atajos de forma reiterada con rapidez para desplazarse por los dibujos hacia atrás o 
hacia delante.

Uso de la barra de herramientas Easy Flipping (Flipping sencillo)

 1. Cambie a la vista de dibujo.

 2. En el menú superior, seleccione Windows > Toolbars > Easy Flipping (Ventanas > Barras de 
herramientas > Flipping sencillo) para habilitar la barra de herramientas Easy Flipping (Flipping 
sencillo).

 3. En la barra de herramientas Easy Flipping (Flipping sencillo), haga clic en el botón Previous 
(Anterior)  o Next (Siguiente)  para ver el dibujo anterior o siguiente de la animación.
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 4. Para mostrar los dibujos del primer fotograma después de llegar al último fotograma de la animación, 
seleccione la opción Loop (Bucle).

 5. Mueva el control deslizante hacia la derecha para desplazarse hacia delante y hacia la izquierda 
para desplazarse hacia atrás por los dibujos.

Cuanto más mueva el control deslizante hacia la izquierda o la derecha, más deprisa se desplazarán 
los dibujos.

 6. En el campo Preroll (Preprocesamiento), introduzca la cantidad de dibujos por los que desplazarse 
automáticamente antes y después del dibujo actual.

 7. En el campo FPS, introduzca la velocidad a la que desee desplazarse automáticamente por los 
dibujos en fotogramas por segundo.

 8. Haga clic en el botón Easy Flip (Flip sencillo) para desplazarse automáticamente por los dibujos en 
función de la configuración de Preroll (Preprocesamiento) y FPS.

Cuando el boceto de animación esté terminado, reprodúzcalo para asegurarse de es lo que se esperaba antes 
de continuar con el siguiente paso.

Reproducción de la animación

 1. En la vista de línea de tiempo, utilice los botones Enable/Disable All (Activar/desactivar todo)  y 
Solo  para desactivar todas las capas que no desee ver durante la reproducción.

 2. En la vista de línea de tiempo, mueva el cabezal rojo al primer fotograma de la animación y haga clic 
en el botón Start (Iniciar) en la barra de herramientas Timeline (Línea de tiempo). A continuación, 
mueva el cabezal al último fotograma de la animación y haga clic en el botón Stop (Detener).
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 3. En la barra de herramientas Playback (Reproducir), haga clic en el botón Loop (Bucle)  para 
habilitar la opción de bucle durante la reproducción.

 4. En la barra de herramientas Playback (Reproducir), haga clic en el botón Play (Reproducir)  para 
comenzar con la reproducción.

Limpieza
Una vez que se haya completado el boceto de animación, es el momento de limpiarlo y tintarlo. A este paso 
también se le denomina trazado. Consiste en trazar líneas sólidas y limpias sobre el boceto de animación para 
cerrar las zonas abiertas. Es el paso final de la animación sin papel antes del paso de ink and paint.

En una animación tradicional, los dibujos de clean up se suelen trazar en una nueva hoja de papel con el boceto 
debajo, que se puede ver con la mesa de luz del disco de animación. Del mismo modo, en Harmony, tendrá que 
agregar una nueva capa de dibujo en el dibujo donde desee dibujar dibujos de clean up. Cuando haya 
terminado la limpieza, simplemente puede desactivar la capa que contiene el boceto de animación para que no 
aparezca en la animación final. Este enfoque también permite mantener los bocetos y los dibujos de clean up 
intactos y administrarlos de manera independiente.

En la vista de cámara, verá el boceto de animación mientras trabaja en la capa de clean up. Si prefiere trabajar 
en la vista de dibujo, puede habilitar la mesa de luz para mostrar el boceto de animación mientras realiza 
trazados en la capa de clean up.

Trazado de la animación en una nueva capa

 1. En la vista de línea de tiempo, cambie el nombre de la capa en la que creó el boceto de animación 
haciendo doble clic en su nombre e introduciendo el nuevo nombre, por ejemplo: "Boceto".

 2. En la vista de línea de tiempo, agregue una capa realizando una de las siguientes acciones:

 l En la barra de herramientas de capas de la vista de línea de tiempo, haga clic en el 
botón Add Drawing Layer (Agregar capa de dibujo) .

 l Pulse Ctrl + R (Windows/Linux) o ⌘  + R (macOS).

Se abre la capa Add Drawing Layer (Agregar capa de dibujo).
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 2. En el campo Name (Nombre), escriba el nombre de la nueva capa, por ejemplo: "Clean-up".

 2. Establezca las opciones Line Art (Capa de líneas) y Colour Art (Capa de color) en Vector para 
obtener una capa de vectores o en Bitmap (Mapa de bits) para tener una capa de mapa de bits.

 3. Haga clic en Add and Close (Agregar y cerrar) para agregar una nueva capa y cerrar la ventana.

Se agrega a la vista de línea de tiempo una nueva capa de dibujo.

 4. En la vista de línea de tiempo, haga clic en el icono Lock (Bloquear)  de la capa que contiene el 
boceto de animación para impedir que dicha capa se pueda seleccionar en la vista de cámara.

 5. En la vista de línea de tiempo o de carta de rodaje, seleccione la celda de la nueva capa que 
corresponda al primer dibujo clave del boceto de animación.
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 6. En la barra de herramientas Tools (Herramientas), seleccione una herramienta de dibujo, como la 
herramienta Pencil (Lápiz) .

 7. En la vista de color, seleccione un color para trazar la animación. Seleccione un color oscuro intenso, 
como el negro, para asegurarse de conseguir un contraste adecuado con el color claro del boceto de 
animación.

 8. En la vista de cámara o de dibujo, comience a trazar el primer dibujo clave.

NOTA

Si las capas de superposición están en medio, puede deshabilitarlas 
temporalmente haciendo clic en su botón Enable/Disable (Habilitar/deshabilitar) 

 en la vista de línea de tiempo para que solo se muestren el boceto de 
animación y las capas de clean up.

 9. En la vista de línea de tiempo o de carta de rodaje, seleccione la siguiente celda que corresponda a 
un boceto de dibujo.

 10. En la barra de herramientas Tools (Herramientas), haga clic en el botón Enable Onion Skin (Activar 
papel cebolla) .

 11. Asegúrese de que el papel cebolla muestre el dibujo de clean up anterior realizando una de las 
siguientes acciones:

 l En la vista de línea de tiempo, arrastre los marcadores azules de papel cebolla para 
ampliar el número de dibujos anteriores y siguientes para que se visualicen como papel 
cebolla.
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 l En la barra de herramientas Camera View (Vista de cámara) o Drawing View (Vista de 
dibujo), utilice los botones Onion Skin Add One Previous Drawing (Agregar un dibujo 
anterior de papel cebolla) , Onion Skin Reduce One Previous Drawing (Reducir un 
dibujo anterior de papel cebolla) , Onion Skin Reduce One Next Drawing (Reducir 
un dibujo siguiente de papel cebolla)  y Onion Skin Add One Next Drawing 
(Agregar un dibujo siguiente de papel cebolla)  para ajustar la extensión del papel 
cebolla fotograma a fotograma.

 12. En la vista de cámara, trace el siguiente dibujo.

 13. Repita los pasos anteriores para cada dibujo.
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Capítulo 8: Aplicación de morphing a dibujos

La animación dibujada a mano requiere que pase mucho tiempo trazando dibujos intercalados. La función de 
morphing de Harmony puede ayudar a acelerar el proceso. Esta útil función crea automáticamente dibujos 
generados por ordenador entre los dibujos vectoriales para ahorrar tiempo y aumentar la productividad. Puede 
modificar fácilmente el tiempo y la velocidad (aceleración y desaceleración gradual) de una animación de 
morphing.

Uno de los principales usos de la función de morphing es la animación de efectos. Por ejemplo, la animación de 
humo o agua puede llevar mucho tiempo, ya que estos tipos de efectos suelen ser de movimiento lento, lo que 
requiere un gran número de intercalados estrechamente conectados.

La función de morphing se utiliza para animar formas similares y simples, como pelo o humo. Esto le ayuda a 
ahorrar tiempo durante tareas de intercalado y trazado pesadas. A su vez, le proporciona más tiempo para 
emplearlo en tareas complejas de animación, como ciclos de andar o secuencias acrobáticas.

Para aprender a aplicar morphing a dibujos, es mejor comenzar con formas básicas, como círculos y rectángulos. 
Una vez que esté más familiarizado con la herramienta, puede aumentar sus conocimientos y experiencia. En 
muy poco tiempo, producirá algunos efectos notables.

Es útil conocer los pros y los contras del morphing antes de comenzar. Saber lo que puede hacer y qué líneas de 
dibujo pueden ser más útiles o problemáticas le permitirán diseñar dibujos clave para que se aplique un 
morphing de forma eficiente.

NOTA

Cuanto más compleja es la forma, más tarda el morphing. Si necesita más tiempo para aplicar un 
morphing a un dibujo que para dibujarlo a mano, es mejor animarlo en lugar de aplicar la técnica de 
morphing. Sin embargo, si encuentra una ocasión en la que pueda aplicar un morphing a los dibujos, 
hágalo. Le permite fijar el tiempo y la velocidad rápidamente sin la necesidad de crear dibujos 
adicionales.
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Creación de un elemento de morphing básico

 1. En la barra de herramientas Timeline (Línea de tiempo), haga clic en el botón Add Drawing Layer 
(Agregar capa de dibujo)  para agregar una nueva capa al proyecto.

 2. Cambie el nombre de la nueva capa (por ejemplo, Morphing).

 3. En la vista de línea de tiempo o de carta de rodaje, seleccione la primera celda de la capa.

 4. Realice una de las siguientes acciones:

 l En la barra de herramientas Tools (Herramientas), seleccione la herramienta Rectangle 
(Rectángulo) .

 l Pulse Alt + 7.

 5. En la vista de cámara o de dibujo, dibuje un rectángulo.

NOTA

Al dibujar un rectángulo o una elipse, puede mantener pulsada la tecla Mayús 
para dibujar su forma con las mismas dimensiones, así como para hacer un 
cuadrado o un círculo en su lugar. También puede mantener pulsada la tecla Alt 
para dibujar la forma desde su centro y no desde su esquina.

 6. Pinte el rectángulo con la herramienta Paint (Pintar).

 7. En la vista de carta de rodaje o de línea de tiempo, seleccione la celda en la que desea que termine la 
secuencia de morphing.
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 8. Realice una de las siguientes acciones:

 l En la barra de herramientas Tools (Herramientas), seleccione la herramienta Ellipse 
(Elipse) .

 l Pulse Alt + =.

 9. Dibuje y pinte la elipse con el mismo contorno y colores de relleno que el rectángulo.

 10. En la vista de carta de rodaje o de línea de tiempo, seleccione el rango de fotogramas que va desde 
el primer dibujo hasta el segundo dibujo, incluidos los fotogramas que contienen los mismos.

 11. Realice una de las siguientes acciones:

 l En el menú superior, seleccione Animation > Morphing > Create Morphing (Animación 
> Morphing > Crear morphing).

 l En la vista de carta de rodaje o de línea de tiempo, haga clic con el botón derecho y 
seleccione Morphing > Create Morphing (Morphing > Crear Morphing).

 l Pulse Alt + M.

Aparecen las flechas que van desde el primer dibujo clave hasta el segundo dibujo clave, que indican 
que se han creado los intercalados generados por ordenador.
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Ajuste de la velocidad de morphing
Si observa la animación, notará que el movimiento de morphing es constante. Para producir un movimiento 
menos mecánico, es probable que desee crear alguna aceleración-gradual o desaceleración-gradual.

Adición de aceleración-gradual y desaceleración-gradual a un elemento de morphing

 1. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Morphing  o pulse 
F3.

 2. En la vista de línea de tiempo, haga clic en un fotograma de la secuencia de morphing que desee 
ajustar.

 3. En la vista de propiedades de la herramienta, aumente o reduzca el valor de Ease In (Aceleración-
gradual) y Ease Out (Desaceleración-gradual) para ajustar la velocidad de la secuencia.

Adición de sugerencias de morphing
La herramienta Morphing de Harmony permite controlar la secuencia de morphing de muchas maneras. Una de 
esas maneras es colocar sugerencias para asegurarse de que Harmony transforme los dibujos de la manera que 
tenía prevista.

Las sugerencias son puntos que se colocan en los dibujos de origen y de destino para asociar zonas y líneas 
entre los dos dibujos. Se utilizan para corregir errores de las transformaciones de dibujos que realiza Harmony, 
como una línea que no sigue la zona de relleno de color o cuando una parte del dibujo de origen no se 
transforma en su parte correspondiente del dibujo de destino. De forma predeterminada, Harmony asociará 
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una esquina o un punto en el dibujo de origen con la esquina o punto más cercanos del dibujo de destino. Por lo 
tanto, las sugerencias son necesarias si la forma que se va a transformar o su movimiento son complejos.

Adición de sugerencias

 1. En la vista de línea de tiempo o de carta de rodaje, seleccione el dibujo de origen de la secuencia de 
morphing.

 2. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Morphing  o pulse 
F3.

Utilice como referencia el otro dibujo clave de morphing, mostrado en la esquina inferior derecha de 
la vista de dibujo.

 3. En la vista de propiedades de la herramienta, seleccione el tipo de sugerencia que desea utilizar.

 l Seleccione Contour Hint (Sugerencia de contorno) para corregir el contorno de una 
línea de pincel o de una zona de color (vector de contorno).
Los puntos de Contour Hint (Sugerencia de contorno) se comportarán de manera 
similar a los puntos de Pencil Hint (Sugerencia de lápiz) cuando se utilicen en una línea 
de lápiz. Tenga en cuenta que obtiene mejores resultados utilizando el punto de Pencil 
Hint (Sugerencia de lápiz) en la línea de lápiz en lugar de los puntos de Contour Hint 
(Sugerencia de contorno).

 l Seleccione Pencil Hint (Sugerencia de lápiz) para corregir una línea de lápiz (vector 
central).
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 l Seleccione Zone Hint (Sugerencia de zona) para corregir una coincidencia de 
morphing de zona de color.

 l Seleccione Vanishing Point Hint (Sugerencia de punto de fuga) para corregir la 
trayectoria de una forma de fuga.

 l Seleccione Appearing Point Hint (Sugerencia de punto de aparición) para corregir la 
trayectoria de una forma de aparición.

 4. En la vista de cámara o de dibujo, haga clic en el dibujo situado junto al área problemática.

 5. Seleccione el punto de la sugerencia y muévalo a su posición correcta.

 6. En la vista de línea de tiempo o de carta de rodaje, seleccione el dibujo de destino.

 7. Busque y mueva el punto de la sugerencia correspondiente a la parte correspondiente del dibujo de 
destino.
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 8. En la barra de herramientas Playback (Reproducir), presione el botón Play (Reproducir)  para ver 
el resultado.
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Capítulo 9: Importación de imágenes
De forma predeterminada, Harmony trabaja con imágenes vectoriales creadas dentro de su propia interfaz. Las 
imágenes vectoriales se componen principalmente de información sobre las distintas formas que componen las 
imágenes, así como de sus colores de línea y de relleno. Esto hace que sean fáciles de editar y pintar, y permite 
redimensionarlas sin que afecte a la calidad de la imagen. Por el contrario, las imágenes de mapa de bits se 
componen de información de color sobre cada píxel individual que compone la imagen. Por lo tanto, son más 
adecuadas para imágenes muy detalladas o realistas, pero no se pueden escalar sin perder calidad de imagen y 
no se pueden editar tan fácilmente como las imágenes vectoriales.

Normalmente, es necesario trabajar con imágenes de mapa de bits si debe crear algunos de los recursos de 
escena, como fondos o props, en un software diferente. A continuación, puede importar los archivos de 
imágenes de mapa de bits en su escena de Harmony.

Al importar una imagen de mapa de bits, debe decidir cómo debe procesarla Harmony. Puede elegir entre las 
siguientes opciones:

 l Keep as Original Bitmap (Mantener como mapa de bits original): Importa la imagen exactamente tal 
como está y garantiza que no se pueda modificar cuando se trabaje en la escena. Esta opción es útil para 
utilizar fondos creados en el proyecto con un software diferente.

 l Import as Toon Boom Bitmap Drawing (Importar como dibujo de mapa de bits de Toon Boom): Importa 
la imagen tal como está, pero permite editarla con las herramientas de dibujo de mapa de bits de 
Harmony.

 l Import as Toon Boom Vector Drawing (Importar como dibujo vectorial de Toon Boom): Convierte un 
mapa de bits en un dibujo vectorial de Toon Boom que se puede pintar y editar fácilmente con las 
herramientas de dibujo vectorial de Harmony. Esta opción puede ser útil para la importación de capa de 
líneas escaneadas o creadas con un software diferente.

Importación de una imagen de mapa de bits en su formato original

 1. Realice una de las siguientes acciones:

 l En el menú superior, seleccione File > Import > Images (Archivo > Importar > 
Imágenes).

 l En la barra de herramientas File (Archivo), haga clic en el botón Import Images 
(Importar imágenes) .

 l En la vista de carta de rodaje, haga clic con el botón derecho en cualquier parte del 
área de fotogramas y seleccione Import > Images (Importar > Imágenes).

Se abre el cuadro de diálogo Import Images (Importar imágenes).
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 2. En la sección Files (Archivos) del cuadro de diálogo Import Images (Importar imágenes), haga clic en 
Browse (Examinar) para buscar y seleccionar una o más imágenes en el ordenador.

 3. Agregue la imagen de mapa de bits a una nueva capa seleccionando la opción Create Layer(s) 
(Crear capas) y una de las siguientes opciones:

 l Create Single Layer Named (Crear una sola capa con nombre): Crea una nueva capa 
con el nombre especificado e importa las imágenes en ella.

 l Create Layer(s) Based on Filenames (Crear capas basadas en nombres de archivo): 
Crea una capa basada en cada prefijo de nombre de archivo único. Por ejemplo, si 
importa tres archivos llamados a-1.tga, a-2.tga y b-1.tga, se crearán dos capas, una 
denominada "a" y otra denominada "b". La capa "a" contendrá las dos primeras 
imágenes, mientras que la "b" contendrá la tercera.

 l Add to a Existing Layer (Agregar a una capa existente): Importa las imágenes en la 
capa especificada. Tenga en cuenta que solo puede importar en las capas que son 
compatibles con las opciones de importación. Por ejemplo, si va a importar imágenes 
como dibujos vectoriales, solo puede importarlas en capas de dibujos vectoriales.

 4. En la sección Vectorization (Vectorización), asegúrese de que la opción Vectorize Image (Vectorizar 
imagen) no esté activada.

 5. En la sección Import Options (Opciones de importación), seleccione la opción Keep As Original 
Bitmap (Mantener como mapa de bits original).

 6. En la sección Alignment (Alineación), decida el tamaño y la posición de la imagen dentro del 
encuadre de cámara. Puede elegir entre las siguientes opciones:
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Parámetro Descripción

Fit (Ajustar)

Ajusta el tamaño de la imagen para que se adapte completamente 
al campo de la escena, tanto vertical como horizontalmente, 
asegurándose de que toda la imagen sea visible.

Si la orientación de la imagen es vertical, ajustará la altura de la 
imagen para que se adapte a la altura del campo, sin que afecte a 
la proporción de la imagen:

Si la orientación de la imagen es horizontal, ajustará el ancho de la 
imagen para que se adapte al ancho del campo, sin que afecte a la 
proporción de la imagen:

Pan (Panear)

Tiene el efecto opuesto al parámetro de ajuste. La dimensión más 
pequeña de la imagen se ajustará a la dimensión coincidente del 
fotograma de la escena, y la dimensión más grande de la imagen 
se ajustará proporcionalmente, haciendo que la imagen llene todo 
el campo de la escena y abarque más allá de sus límites si su 
proporción no coincide con la proporción del campo. Esta opción 
se puede utilizar para importar una imagen de fondo de paneo, 
también denominada paneo.

Si la orientación de la imagen es vertical, ajustará el ancho de la 
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imagen para que se adapte al ancho del campo, sin que afecte a 
su proporción:

Si la orientación de la imagen es horizontal, ajustará la altura de la 
imagen para que se adapte a la altura del campo, sin que afecte a 
su proporción:

Project Resolution (Resolución 
del proyecto)

Escala la imagen para que se ajuste a la resolución de la escena, 
haciendo que cada píxel de la imagen tome un píxel del campo de 
la escena. Por ejemplo, si las dimensiones de la imagen en píxeles 
son la mitad de la resolución de la escena en píxeles, las 
dimensiones de la imagen parecen ser la mitad de las dimensiones 
del campo de la escena.

 7. En la sección Transparency (Transparencia) decida cómo desea que se suavice la imagen de mapa 
de bits, en concreto, la forma en que los píxeles a lo largo del borde se mezclan con los otros 
colores. Puede elegir entre las siguientes opciones:

Parámetro Descripción

Premultiplied with White 
(Premultiplicado con blanco)

Los píxeles individuales del borde de una imagen se mezclan con 
blanco.

Premultiplied with Black 
(Premultiplicado con negro)

Los píxeles individuales del borde de una imagen se mezclan con 
negro.
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Straight (Recto)
Los píxeles del borde de una imagen se mezclan con negro, 
blanco y grises.

Clamp Colour to Alpha (Fijar 
color a alfa)

Premultiplica el valor de color con el valor de alfa. Cuando el color 
se fija al alfa, el valor de color no puede ser mayor que el valor de 
alfa. Calcula el valor de color real más rápido. Cuando los valores 
de RGB se multiplican con el valor de alfa, por ejemplo, si tiene un 
píxel con el valor R=247, G=188, B=29 y el alfa es del 50 % o la 
imagen tiene una transparencia del 50 %, los valores de RGB 
reales que se generan serían la mitad de las cantidades indicadas.

 8. Haga clic en OK (Aceptar).

NOTA

De forma predeterminada, las imágenes de mapa de bits se mostrarán en baja resolución en la 
vista de cámara para evitar que afecten al rendimiento de la reproducción. También puede 
ajustar la calidad de visualización de una imagen de mapa de bits seleccionándola con la 
herramienta Transform (Transformar) y, a continuación, abriendo el cuadro de diálogo Bitmap 
Image Quality (Calidad de la imagen de mapa de bits) a través de View > Bitmap File Quality 
(Vista > Calidad del archivo de mapa de bits). También puede previsualizar la imagen de mapa 
de bits en la resolución de la escena activando el modo Render Preview (Vista previa de 
render)  en la vista de cámara.

Vectorización de imágenes
Harmony permite importar imágenes como dibujos vectoriales. Los dibujos vectoriales se pueden pintar y editar 
fácilmente con las herramientas de dibujo vectorial de Harmony. Esto puede ser útil para la importación de 
capas de líneas escaneadas o creadas con un software diferente, ya que luego puede pintarlas en Harmony.

Importación de una imagen de mapa de bits como un dibujo de mapa de bits de Toon 
Boom

 1. Realice una de las siguientes acciones:

 l En el menú superior, seleccione File > Import > Images (Archivo > Importar > 
Imágenes).

 l En la barra de herramientas File (Archivo), haga clic en el botón Import Images 
(Importar imágenes) .

 l En la vista de carta de rodaje, haga clic con el botón derecho en cualquier parte del 
área de fotogramas y seleccione Import > Images (Importar > Imágenes).

Se abre el cuadro de diálogo Import Images (Importar imágenes).
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 1. En la sección Files (Archivos) del cuadro de diálogo Import Images (Importar imágenes), haga clic en 
Browse (Examinar) para seleccionar una o más imágenes del ordenador.

 2. Seleccione el destino de las imágenes:

 l Create Single Layer Named (Crear una sola capa con nombre): Crea una nueva capa 
con el nombre especificado e importa las imágenes en ella.

 l Create Layer(s) Based on Filenames (Crear capas basadas en nombres de archivo): 
Crea una capa basada en cada prefijo de nombre de archivo único. Por ejemplo, si 
importa tres archivos llamados a-1.tga, a-2.tga y b-1.tga, se crearán dos capas, una 
denominada "a" y otra denominada "b". La capa "a" contendrá las dos primeras 
imágenes, mientras que la "b" contendrá la tercera.

 l Add to a Existing Layer (Agregar a una capa existente): Importa las imágenes en la 
capa especificada. Tenga en cuenta que solo puede importar en las capas que son 
compatibles con las opciones de importación. Por ejemplo, si va a importar imágenes 
como dibujos vectoriales, solo puede importarlas en capas de dibujos vectoriales.

 2. En la sección Alignment (Alineación), decida el tamaño y la posición de la imagen dentro del 
encuadre de cámara. Puede elegir entre las siguientes opciones:

Parámetro Descripción

Vertical Fit (Ajuste vertical)
Ajusta el tamaño de la imagen para que su altura coincida con la 
altura de la escena, sin que afecte a su proporción.

65

Guía de introducción de Toon Boom Harmony 15 Advanced



Capítulo 9: Importación de imágenes

Horizontal Fit (Ajuste horizontal)

Ajusta el tamaño de la imagen para que su anchura coincida con 
la anchura de la escena, sin que afecte a su proporción.

Actual Size (Tamaño real)

Importa la imagen a tamaño real sin ajustar su tamaño en 
proporción a la resolución de la escena. Por ejemplo, si las 
dimensiones de la imagen en píxeles son la mitad de la resolución 
de la escena en píxeles, las dimensiones de la imagen parecen ser 
la mitad de las dimensiones del campo de la escena.

 3. En la sección Transparency (Transparencia) decida cómo desea que se suavice la imagen de mapa 
de bits, en concreto, la forma en que los píxeles a lo largo del borde se mezclan con los otros 
colores. Puede elegir entre las siguientes opciones:

Parámetro Descripción

Premultiplied with White 
(Premultiplicado con blanco)

Los píxeles individuales del borde de una imagen se mezclan con 
blanco.

Premultiplied with Black 
(Premultiplicado con negro)

Los píxeles individuales del borde de una imagen se mezclan con 
negro.

Straight (Recto)
Los píxeles del borde de una imagen se mezclan con negro, 
blanco y grises.
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 4. Haga clic en OK (Aceptar).

Importación y vectorización de una imagen de mapa de bits

 1. Realice una de las siguientes acciones:

 l En el menú superior, seleccione File > Import > Images (Archivo > Importar > 
Imágenes).

 l En la barra de herramientas File (Archivo), haga clic en el botón Import Images 
(Importar imágenes) .

 l En la vista de carta de rodaje, haga clic con el botón derecho en cualquier parte del 
área de fotogramas y seleccione Import > Images (Importar > Imágenes).

Se abre el cuadro de diálogo Import Images (Importar imágenes).

 1. En la sección Files (Archivos) del cuadro de diálogo Import Images (Importar imágenes), haga clic en 
Browse (Examinar) para seleccionar una o más imágenes del ordenador.

 2. Seleccione el destino de las imágenes:

 l Create Single Layer Named (Crear una sola capa con nombre): Crea una nueva capa 
con el nombre especificado e importa las imágenes en ella.

 l Create Layer(s) Based on Filenames (Crear capas basadas en nombres de archivo): 
Crea una capa basada en cada prefijo de nombre de archivo único. Por ejemplo, si 
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importa tres archivos llamados a-1.tga, a-2.tga y b-1.tga, se crearán dos capas, una 
denominada "a" y otra denominada "b". La capa "a" contendrá las dos primeras 
imágenes, mientras que la "b" contendrá la tercera.

 l Add to a Existing Layer (Agregar a una capa existente): Importa las imágenes en la 
capa especificada. Tenga en cuenta que solo puede importar en las capas que son 
compatibles con las opciones de importación. Por ejemplo, si va a importar imágenes 
como dibujos vectoriales, solo puede importarlas en capas de dibujos vectoriales.

 3. En la sección Import Options (Opciones de importación), seleccione la opción Convert to Toon Boom 
Vector Drawing (Convertir en dibujo vectorial de Toon Boom).

 4. En la sección Vectorization (Vectorización), decida si desea importar la imagen en blanco y negro o 
en escala de grises. También puede hacer clic en el botón New Preset (Nuevo valor predef.)  para 
crear un parámetro de vectorización personalizado.

‣ Black and White (Blanco y negro): Vectoriza los dibujos como una línea negra sólida; crea un 
dibujo 100 % basado en vectores. Los contornos de los dibujos se pintarán con la muestra de 
color de la línea vectorizada de la paleta de colores de la escena.

‣ Grey (Gris): Vectoriza la imagen como una mezcla de contorno de vectores y relleno de mapa de 
bits en escala de grises. Las líneas conservan la textura de la digitalización y el blanco del papel 
pasa a ser transparente.

NOTA

Puede hacer doble clic en cualquiera de los valores predefinidos en cualquier momento para 
abrir el cuadro de diálogo Vectorization Parameters (Parámetros de vectorización) para 
personalizar la opción.

 5. Haga clic en OK (Aceptar).
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Las imágenes vectorizadas aparecerán en los destinos seleccionados.

NOTA

Si tiene imágenes de mapa de bits en la librería, puede arrastrarlas y colocarlas directamente en la 
escena como una manera rápida de importar una imagen de mapa de bits. Sin embargo, no tendrá 
acceso a todas las opciones de importación.
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Capítulo 10: Configuración de una escena
La configuración de una escena se puede comparar con la construcción de la escenografía para un programa de 
televisión. Este es el punto en el que coloca el elemento de escena, como el encuadre de cámara, los elementos 
de fondo y los personajes.

Adición de una cámara
De forma predeterminada, una escena no tiene capa de cámara. Para poder ajustar el ángulo de la cámara y la 
posición de la escena, debe agregar una a su escena. Aunque es posible tener varias cámaras en la misma 
escena, solo puede ver la escena utilizando las cámaras de una en una. Esto puede resultar útil si aún está 
trabajando en la composición de escena y tiene distintas configuraciones de cámara para probar.

Adición de una cámara en la vista de línea de tiempo o en el menú superior

 1. Realice una de las siguientes acciones:

 l En la vista de línea de tiempo, haga clic en el botón Add Layer (Agregar capa)  y 
seleccione Camera (Cámara).

 l En el menú superior, seleccione Insert > Camera (Insertar > Cámara).

Se agrega a la escena una nueva capa de cámara y aparece en la vista de línea de tiempo.

Cambio entre cámaras

 1. En el menú superior, seleccione Scene > Camera (Escena > Cámara).

 2. Entre las cámaras en la lista, seleccione la cámara con la que desea trabajar.

Colocación de la cámara
La acción de la escena tiene lugar dentro del encuadre de cámara, de modo que es muy importante configurarlo 
correctamente. Puede ajustar la resolución de la cámara y otros parámetros relacionados en la ventana Scene 
Settings (Configuración de escena), a la que se puede acceder desde el menú superior Scene (Escena).

Tenga en cuenta que la capa de cámara es estática. Si necesita animarla, debe colocarla debajo de un peg que 
puede animar (consulte Animación de la cámara en la página 81).
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Puede cambiar la posición del encuadre de cámara directamente en la vista de cámara utilizando las 
herramientas Translate (Traslación) , Rotate (Rotar) y Scale (Escalar)  de la barra de herramientas 
Advanced Animation (Animación avanzada). Otra forma de configurar la cámara es escribiendo las 
coordenadas directamente en las propiedades de la cámara. Esto puede ser útil si ha planificado la escena en 
papel, ya que las coordenadas coinciden con las de una cuadrícula de cámara de animación tradicional. Por lo 
tanto, el uso de este enfoque permite colocar la cámara exactamente donde desee.

Cambio de lugar del encuadre de cámara en la vista de cámara

 1. En la barra de herramientas Tools (Herramientas), desactive el modo Animate (Animar) .

 2. Realice una de las siguientes acciones:

 l En el menú superior, seleccione Animation > Tools > Translate (Animación > 
Herramientas > Traslación).

 l En la barra de herramientas Advanced Animation (Animación avanzada), haga clic en 
la herramienta Translate (Traslación) .

 l Pulse Alt + 2.

 3. En la vista de cámara, haga clic en el encuadre de cámara (rectángulo delgado) para seleccionarlo. 
También puede seleccionar la capa de cámara en la vista de línea de tiempo.

Se resalta el encuadre de cámara seleccionado.
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 4. Arrastre el encuadre de cámara a una nueva posición.

 5. Para rotar el encuadre de cámara, realice una de las siguientes acciones para seleccionar la 
herramienta Rotate (Rotar):

 l En el menú superior, seleccione Animation > Tools > Rotate (Animación > 
Herramientas > Rotar).

 l En la barra de herramientas Advanced Animation (Animación avanzada), seleccione la 
herramienta Rotate (Rotar) .

 l Pulse Alt + 3.
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 6. En la vista de cámara, arrastre para rotar el encuadre de cámara hasta que alcance el ángulo de 
rotación deseado.

 7. Para mover el encuadre de cámara más cerca o más lejos de la escena, realice una de las siguientes 
acciones para seleccionar la herramienta Scale (Escalar):

 l En el menú superior, seleccione Animation > Tools > Scale (Animación > Herramientas 
> Escalar).

 l En la barra de herramientas Advanced Animation (Animación avanzada), seleccione la 
herramienta Rotate (Rotar) .

 l Pulse Alt + 4.
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NOTA

La herramienta Transform (Transformar) también se puede utilizar para mover la cámara, pero 
no para rotarla o escalarla.

Colocación de objetos
La configuración de la escena también implica la colocación de los distintos elementos de la escena dentro del 
encuadre de cámara.

Paneo de una capa con la herramienta Transform (Transformar)

 1. En la barra de herramientas Tools (Herramientas), desactive el modo Animate (Animar) .

 2. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Transform 
(Transformar)  o pulse Mayús + T.

 3. En la vista de propiedades de la herramienta, asegúrese de que esté desactivada la opción Peg 
Selection Mode (Modo de selección de peg) .

 4. En la vista de cámara, seleccione una capa de dibujo. Si desea seleccionar varias capas, mantenga 
pulsada la tecla Mayús y haga clic en cada capa que desee seleccionar.

 5. Arrastre la selección a una nueva área.

Rotación de una capa con la herramienta Transform (Transformar)

 1. En la barra de herramientas Tools (Herramientas), desactive el modo Animate (Animar) .

 2. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Transform 
(Transformar)  o pulse Mayús + T.

 3. En la vista de propiedades de la herramienta, asegúrese de que esté desactivada la opción Peg 
Selection Mode (Modo de selección de peg) .
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 4. En la vista de cámara, seleccione una capa de dibujo. Si desea seleccionar varias capas, mantenga 
pulsada la tecla Mayús y haga clic en cada capa que desee seleccionar.

 5. Coloque el puntero fuera de una esquina del cuadro de límite y, a continuación, arrástrelo para rotar.

NOTA

Al transformar una capa, puede visualizar un controlador de rotación en el cuadro 
de límite. En el cuadro de diálogo Preferences (Preferencias), seleccione la 
pestaña Camera (Cámara) y, a continuación, seleccione la opción Use Rotation 
Lever with Transformation Tools (Usar palanca de rotación con herramientas de 
transformación). Esta preferencia está desactivada de forma predeterminada. 

Escalado de una capa con la herramienta Transform (Transformar)

 1. En la barra de herramientas Tools (Herramientas), desactive el modo Animate (Animar) .

 2. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Transform 
(Transformar)  o pulse Mayús + T.

 3. En la vista de propiedades de la herramienta, asegúrese de que esté desactivada la opción Peg 
Selection Mode (Modo de selección de peg) .

 4. En la vista de cámara, seleccione una capa de dibujo. Si desea seleccionar varias capas, mantenga 
pulsada la tecla Mayús y haga clic en cada capa que desee seleccionar.

 5. Haga clic y arrastre el punto de control superior, lateral o de esquina.
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NOTA

Al realizar el escalado de la selección, puede mantener pulsada la tecla Mayús para mantener 
las proporciones entre la anchura y la altura.

Sesgo de una capa con la herramienta Transform (Transformar)

 1. En la barra de herramientas Tools (Herramientas), desactive el modo Animate (Animar) .

 2. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Transform 
(Transformar)  o pulse Mayús + T.

 3. En la vista de propiedades de la herramienta, asegúrese de que esté desactivada la opción Peg 
Selection Mode (Modo de selección de peg) .

 4. En la vista de cámara, seleccione una capa de dibujo. Si desea seleccionar varias capas, mantenga 
pulsada la tecla Mayús y haga clic en cada capa que desee seleccionar.

 5. Sitúe el puntero sobre el borde del cuadro de límite de la selección, entre dos puntos de control, y 
arrástrelo hacia los lados o arriba y abajo.

Cambio de posición del pivote
Las transformaciones realizadas sobre una capa de dibujo, tales como rotación, escala, sesgo y volteo, se 
realizan respecto a la posición del punto de pivote del dibujo. Mientras realiza transformaciones con la 
herramienta Transform (Transformar), puede arrastrar y colocar el pivote de la selección. Sin embargo, esto no 
tiene un efecto permanente. Solo cambiará temporalmente la posición del pivote para que le ayude a realizar 
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transformaciones en el fotograma seleccionado, pero el punto de pivote real de la capa de dibujo permanecerá 
igual. Puede cambiar de forma permanente la posición del punto de pivote de una capa utilizando las 
herramientas de animación avanzada.

Cambio de posición permanente del punto de pivote

 1. En la barra de herramientas Advanced Animation (Animación avanzada), seleccione la herramienta 
Translate (Traslación) , Rotate (Rotar) , Scale (Escalar)  o Skew (Sesgar) .

 2. En la vista de cámara, Ctrl + clic (Windows/Linux) o ⌘  + clic (macOS) para seleccionar el elemento.

El punto de pivote aparece en la vista de cámara.

 3. Arrastre el punto de pivote a una nueva posición.

NOTA

Al mover de forma permanente el punto de pivote de una capa que ya está animada, todas las 
transformaciones realizadas en la capa en otros fotogramas clave se volverán a calcular de 
acuerdo con la posición del nuevo punto de pivote. Por lo tanto, la animación existente parecerá 
completamente diferente, excepto en el fotograma actual. Es recomendable que siempre se 
asegure de que el punto de pivote se encuentre en la posición idónea antes de comenzar la 
animación.
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Capítulo 11: Animación de objetos y de la cámara
En Harmony, puede animar objetos dibujándolos en su capa individual y colocándolos a continuación en 
distintas ubicaciones en diferentes fotogramas clave a través de la línea de tiempo para crear una ruta de 
movimiento. Se puede aplicar el mismo principio a la cámara de la escena, ya que se trata de una capa.

Animación de una capa
Puede crear la ruta de movimiento directamente en capas (capas animadas).

Puede controlar y definir una trayectoria utilizando varios parámetros distintos, incluidos:

 l Posiciones X, Y y Z

 l Ángulo (rotación)

 l Sesgar

 l Escalas X e Y

Harmony mantiene el desglose de la animación almacenando cada parámetro de cada capa en su propia curva 
de función. Al agregar un fotograma clave a una capa, se crea un fotograma clave en cada una de estas 
funciones y las transformaciones realizadas en una capa mediante la vista de cámara se convierten en 
coordenadas, que a continuación se almacenan en dichas funciones. Es posible editar estas funciones de 
manera individual con la vista de función, pero no suele ser necesario, ya que Harmony ofrece herramientas 
fáciles de usar para controlar visualmente las trayectorias y el tiempo en las vistas de cámara y línea de tiempo.
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Animación de una capa o un peg

 1. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Transform 
(Transformar)  o pulse Mayús + T.

 2. Si la capa tiene un peg padre y desea animar la capa de dibujo directamente, asegúrese de que el 
modo Peg Selection (Selección de peg)  esté deshabilitado en la vista de propiedades de la 
herramienta.

 3. En la barra de herramientas Tools (Herramientas), active el modo Animate (Animar) . Esto 
permite que la herramienta Transform (Transformar) afecte a la posición y al tamaño de una capa 
solo en el fotograma clave actual, mientras que, en caso contrario, afectaría a la posición y al tamaño 
de la capa en toda la escena.

 4. En la vista de línea de tiempo, vaya al primer fotograma.

 5. En el menú superior, seleccione Animation (Animación) y asegúrese de que la opción Stop-Motion 
Keyframe (Fotograma clave de Stop-motion) no esté activada. De este modo, Harmony creará la 
animación automáticamente entre los fotogramas clave de la animación que cree.

 6. Seleccione la celda donde desee crear el primer fotograma clave.

 7. Para crear el primer fotograma clave, realice una de las siguientes acciones:

 l En la barra de herramientas Timeline (Línea de tiempo), haga clic en el botón Add 
Keyframe (Agregar fotograma clave) .

 l Haga clic con el botón derecho y seleccione Add Keyframe (Agregar fotograma clave).

 l Pulse F6.

Se crea un fotograma clave en el primer fotograma de la vista de línea de tiempo.
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 8. En la vista de cámara, seleccione el elemento que desea animar y muévalo a su primera posición.

 9. En la vista de línea de tiempo, vaya al fotograma en el que desea establecer la segunda posición.

 10. Seleccione la celda donde desee crear el segundo fotograma clave. Haga clic con el botón derecho en 
la selección y seleccione Insert Keyframe (Insertar fotograma clave).

Aparece el segundo fotograma clave junto con una línea que va desde el primer fotograma clave al 
segundo fotograma clave. Esto indica que Harmony interpolará cada fotograma intercalado.

 11. En la vista de cámara, mueva el elemento a su segunda posición.
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 12. En la vista de línea de tiempo, seleccione el primer fotograma para retroceder al comienzo de la 
animación.

 13. En la barra de herramientas Playback (Reproducir), haga clic en el botón Play (Reproducir)  para 
obtener una vista previa de la animación.

NOTA

Si anima capas en el eje Z, puede que desee obtener una vista previa de las animaciones desde 
las vistas superior, lateral o de perspectiva durante la reproducción. Sin embargo, la 
reproducción está deshabilitada de forma predeterminada en esas vistas. Para habilitarla, en el 
menú superior seleccione Play > Enable Playback > Top View (Reproducir > Activar 
reproducción > Vista superior), Side View (Vista lateral) o Perspective View (Vista de 
perspectiva).

Animación de la cámara
La cámara de una escena se puede manipular y animar como cualquier otra capa. Se muestra en la vista de línea 
de tiempo y puede utilizar las mismas herramientas y modos de selección para desplazarla o animarla. Sin 
embargo, la capa de la cámara en sí es estática, lo que significa que mantiene la misma posición y ángulo en toda 
la escena. Para poder animar la cámara, es necesario conectarla a una capa de peg, que se puede animar, y que 
afectará directamente a la posición y al ángulo de la cámara.

Puede animar los movimientos de la cámara directamente en la vista de cámara. También puede utilizar las 
vistas lateral o superior, que pueden ser especialmente útiles al animar una cámara en una escena de 
multiplano, donde cada capa se coloca a una distancia diferente de la cámara.
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Apertura de las vistas superior y lateral

 1. Realice una de las siguientes acciones:

 l En el menú superior, seleccione Windows > Top (Ventanas > Superior) o Side 
(Lateral).

 l Desde cualquier vista que ya esté abierta, haga clic en el botón Add View (Agregar 
vista)  situado en la esquina superior derecha y seleccione Top (Superior) o Side 
(Lateral).

Adición de una cámara y su peg padre

 1. De forma predeterminada, las nuevas escenas no tienen una capa de cámara. Para agregar una 
capa de cámara, realice una de las siguientes acciones:

 l En el menú superior, seleccione Insert > Camera (Insertar > Cámara).

 l En la barra de herramientas Layers (Capas), haga clic en el botón Add Layers (Agregar 
capas)  y seleccione Camera (Cámara).

Se agrega a la escena una nueva capa de cámara y aparece en la vista de línea de tiempo.

 2. En la vista de línea de tiempo, seleccione la capa de cámara.

 3. En la barra de herramientas Layers (Capas), haga clic en el botón Add Peg (Agregar peg) .

Aparece una capa de peg directamente sobre la capa de cámara y se conecta a ella 
automáticamente. La nueva capa de peg toma el nombre de la capa de cámara con el sufijo -P 
agregado para indicar que se trata de su capa de peg.

Si la nueva capa de peg no aparecía directamente encima de la cámara, puede que haya hecho clic 
en algún otro lugar de la escena que desactivase la capa a la que desea agregar la capa de peg. Para 
resolverlo:
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 l Seleccione la capa de cámara y arrástrela y colóquela debajo de la nueva capa de peg. 
O bien, elimine la capa de peg mal colocada, seleccione la capa de cámara y haga clic 
de nuevo en el botón Add Peg  (Agregar peg).

También puede pulsar Ctrl + P (Windows/Linux) o ⌘  + P (macOS) para crear un peg y 
conectarlo a la cámara.

Animación de la cámara

 1. En la barra de herramientas Tools (Herramientas), active el modo Animate (Animar) .

 2. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Transform 
(Transformar)  o pulse Mayús + T.

 3. En el lado derecho de la vista de línea de tiempo, en la capa de peg de cámara, seleccione el 
fotograma en el que desee que comience el movimiento de cámara.

 4. Realice una de las siguientes acciones para agregar un fotograma clave:

 l En la barra de herramientas Timeline (Línea de tiempo), haga clic en el botón Add 
Keyframe (Agregar fotograma clave) .

 l Haga clic con el botón derecho y seleccione Add Keyframe (Agregar fotograma clave).

 l Pulse F6.

Aparece un fotograma clave en dicha celda. Los fotogramas que preceden a este fotograma clave 
mantendrán la misma posición de cámara que este fotograma clave.

 5. Realice una de las siguientes acciones para mover la cámara:

 l En la vista de cámara, seleccione la cámara, que ahora se representa con un rectángulo 
delgado y amarillo con un resaltado rojo, y muévalo a la posición deseada.
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 l En la vista superior o lateral, seleccione la cámara, que ahora se representa con un cono 
grande y amarillo en forma de V, y muévalo a la posición deseada.

 6. En la vista de línea de tiempo, haga clic en la celda en la que terminará el movimiento de cámara.

 7. Realice una de las siguientes acciones:

 l En la barra de herramientas Timeline (Línea de tiempo), haga clic en el botón Add 
Keyframe (Agregar fotograma clave) .

 l Haga clic con el botón derecho y seleccione Add Keyframe (Agregar fotograma clave).

 l Pulse F6.

Aparece un fotograma clave en dicha celda.
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 8. Seleccione la cámara en la vista de cámara, superior o lateral, y muévala a la posición deseada.

 9. En la vista de línea de tiempo, seleccione el primer fotograma para retroceder al comienzo de la 
animación.

 10. En la barra de herramientas Playback (Reproducir), haga clic en el botón Play (Reproducir)  para 
obtener una vista previa de la animación.
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Capítulo 12: Creación de un rig de un personaje Cut-
out
En Harmony, un rig de personaje es básicamente una plantilla basada en el modelo del personaje, pero en la 
cual todas las partes móviles están divididas en distintas capas y ordenadas en una jerarquía que facilita la 
animación digital, también conocida como animación cut-out.

Para realizar un rig de personaje, en primer lugar debemos asegurarnos de tener un modelo de personaje del 
que partir. Si tiene un dibujo de un personaje disponible, impórtelo en una nueva escena y, a continuación, 
ajuste la escala y colóquelo a su gusto. De lo contrario, puede dibujar el modelo del personaje directamente en 
Harmony. Una vez que tenga listo un modelo, podemos comenzar a descomponerlo en partes para crear el rig 
con él.

Se pueden emplear muchas técnicas para descomponer una marioneta. En esta sección, aprenderá uno de los 
métodos más comunes y sencillos. Para la primera descomposición de personaje, siga estas instrucciones para 
hacerse una idea de cómo funciona Harmony. Una vez que conozca las funciones y comandos básicos de 
Harmony, podrá crear sus propias técnicas para cumplir las necesidades de su producción.

Dibujo de las piezas
La técnica de descomposición principal que se muestra es el trazado del modelo.

Descomposición de un personaje mediante trazado

 1. En la vista de línea de tiempo, añada una nueva capa de dibujo para cada parte del cuerpo que 
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desee separar. Puede pulsar Ctrl + R (Windows/Linux) o ⌘  + R (macOS).

 2. En la vista de línea de tiempo, seleccione la primera celda de la capa en la que desea dibujar la parte.

 3. En la barra de herramientas Tools (Herramientas), seleccione la herramienta de dibujo que desee. Se 
suelen utilizar dos métodos para dibujar las partes de un modelo de personaje cut-out:

 l Utilizar la herramienta Pencil (Lápiz)  y suavizar las líneas con la herramienta 
Smooth Editor (Editor de suavidad) .

 l Utilizar la herramienta Polyline (Polilínea) . Este método permite dibujar con gran 
precisión, pero puede llevar más tiempo.

Estos métodos garantizan que cada parte se realice con el menor número de puntos posible, para 
que sean fáciles de manipular, modificar o volver a dibujar.

 4. En la vista de color, seleccione una muestra de color. Si todavía no ha creado ninguna paleta para el 
personaje, consulte  Cómo pintar en la página 34.

 5. Si prefiere trabajar en la vista de dibujo, realice una de las siguientes acciones para mostrar las 
demás capas con colores lavados:

 l En la barra de herramientas de la vista de dibujo, haga clic en el botón Light Table 
(Mesa de luz) .

 l Pulse Mayús + L.

 6. En la vista de cámara o de dibujo, dibuje la nueva parte.
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 7. Si desea cerrar una forma abierta sin dibujar un contorno visible, puede dibujar una línea visible con 
la herramienta Stroke (Línea vectorial transparente) .

NOTA

Las líneas vectoriales transparentes no son visibles de forma predeterminada. Para ver 
las líneas vectoriales transparentes en el dibujo, seleccione View > Show > Show 
Strokes (Ver > Mostrar > Mostrar líneas vectoriales transparentes) en el menú superior o 
pulse K.

 8. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Paint (Pintar)  o 
pulse Paint Unpainted (Pintar despintado)  para colorear el dibujo.

 9. En la vista de color, cree el color de relleno deseado si no se encuentra todavía en la paleta y, a 
continuación, selecciónelo.

 10. En la vista de cámara o de dibujo, pinte el dibujo.
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 11. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Select (Seleccionar) . 
Seleccione el dibujo y acople las líneas haciendo clic en el botón Flatten (Acoplar)  de la vista de 
propiedades de la herramienta.

 12. Si las líneas están compuestas por varias pinceladas de lápiz, puede que desee combinarlas en una 
única línea de lápiz fluida. Mediante la herramienta Select (Seleccionar), seleccione las líneas de lápiz 
que se deben combinar y, en la vista de propiedades de la herramienta, haga clic en la herramienta 
Merge Pencil Lines (Combinar líneas de lápiz) .

 13. Repita todo el proceso para cada parte del cuerpo que desee que se pueda animar.
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Adición de pegs
Los pegs son un tipo especial de capa que no contiene ningún dibujo. Solo se utilizan para desplazar y 
transformar dibujos que estén debajo su jerarquía, sin transformar directamente los dibujos.

Al crear un rig o configurar una escena, se recomienda añadir pegs padres a cada una de las capas de dibujo. 
Esto permite mantener los fotogramas clave y los dibujos de animación en capas separadas, lo que facilita el 
trabajo sobre la posición y exposición de las capas de dibujo por separado en la vista de línea de tiempo. 
También facilita la creación de una jerarquía de las partes del cuerpo que se pueden animar juntas y por 
separado.

Si desea animar solo sobre pegs, puede activar el modo Peg Selection (Selección de peg) de la herramienta 
Transform (Transformar) en la vista de propiedades de la herramienta. También puede deshabilitar las capas de 
dibujo de animación, de forma que solo se puedan animar los pegs.
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NOTA

También es posible hacer que una capa de dibujo esté emparentada con otra capa de dibujo. Al 
igual que la forma de animación de un peg anima sus capas hijas, la animación de una capa de dibujo 
con hijas también animará sus capas hijas. Ambas capas seguirán apareciendo en la animación.

Creación de pegs padres para las capas en la vista de línea de tiempo

 1. En la vista de línea de tiempo, seleccione todas las capas.

 2. En la barra de herramientas Timeline Layer (Capa de línea de tiempo), haga clic en el botón Add Peg 
(Agregar peg)  para agregar un peg padre a todas las capas seleccionadas.

Creación de una jerarquía de capas
Harmony permite crear el rig en una jerarquía elaborada, lo que le permite a su vez establecer qué partes del rig 
deben influir en otros miembros y cómo pueden moverse de forma independiente. Por ejemplo, al crear un rig 
del brazo de un personaje simple, puede hacer que la capa del antebrazo sea hija de la capa del brazo, y que la 
capa de la mano sea hija de la capa del antebrazo. De esta manera, si el personaje mueve el antebrazo, la mano 
también lo hará, y si mueve el brazo, el antebrazo y la mano también lo harán.
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Capítulo 12: Creación de un rig de un personaje Cut-out

Al crear un rig de personaje básico, debe tener al menos una jerarquía para cada brazo y cada pierna. Puede 
crear una jerarquía que vaya desde el torso, el cuello y la cabeza, y crear un rig de los brazos al torso y otro de las 
piernas a las caderas. Esto crearía una jerarquía como esta:

Creación de una jerarquía en la vista de línea de tiempo

 1. En el área izquierda de la vista de línea de tiempo, seleccione la capa que desee que sea la capa hija.

 2. Arrastre la hija y colóquela sobre la capa que desee que sea la capa padre. Asegúrese de no colocar 
la capa hija entre dos capas.

 3. Repita el proceso hasta que haya creado una jerarquía que cree un rig de todas las partes del 
personaje, con un peg maestro en la raíz. Al crear un rig, si desea que varias capas tengan un padre 
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común, pero ninguna de las partes existentes del rig puede servir como dicho padre, cree un nuevo 
peg y anide esas capas debajo de dicho peg.

NOTA

En la vista de línea de tiempo, puede desconectar una capa de su capa padre manteniendo 
pulsada la tecla Mayús, arrastrando la capa padre lejos de la capa hija y colocándola en 
cualquier lugar de la lista.

Al crear un rig, tenga en cuenta que el orden de las capas en la vista de línea de tiempo afecta al orden en que 
se representan. Las capas de la parte superior de la lista se representarán sobre las capas de la parte inferior de 
la lista.  Si tiene que cambiar el orden de una capa durante la animación, puede realizar un desplazamiento 
pequeño de la posición de esta capa sobre el eje Z para anular el orden de la capa y forzarla a aparecer debajo 
de otras capas o sobre ellas.

Desplazamiento pequeño de una capa sobre el eje Z

 1. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Transform 
(Transformar) .

 2. En la vista de línea de tiempo, de nodos o de cámara, seleccione la capa que desea desplazar.

 3. Si ha seleccionado la capa en la vista de línea de tiempo o de nodos, haga clic en la pestaña de la 
vista de cámara para establecer el enfoque en esta vista.

 4. Realice una de las siguientes acciones:

 l Para realizar un desplazamiento pequeño de la capa hacia delante, pulse Alt + flecha 
abajo.
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 l Para realizar un desplazamiento pequeño de la capa hacia atrás, pulse Alt + flecha 
arriba.

Peg maestro
El rig del personaje siempre debe tener un peg maestro que se conecte a todas sus partes. El peg maestro 
permite manipular todo el rig desde una única capa, sin necesidad de manipular cada parte individual. Esto es 
útil para colocar y escalar el personaje en relación a la escena, así como para animar la trayectoria del personaje 
cuando tiene que moverse entre las áreas de la escena.

Adición de un peg maestro en la vista de línea de tiempo

 1. En la vista de línea de tiempo, seleccione la capa superior.

 2. En la vista de línea de tiempo, haga clic en el botón Add Peg (Agregar peg) .

Se agrega a la línea de tiempo un nuevo peg al que queda emparentada la capa seleccionada.

 3. Asigne el nombre Master más el nombre del personaje al nuevo peg.

 4. En la vista de línea de tiempo, seleccione todas las capas que desee conectar al nuevo peg. Recuerde 
que la capa superior ya es hija del peg, así que no la incluya en la selección.

 5. Arrastre la selección SOBRE la capa del peg para emparentar todas las piezas del personaje al peg. 
Si se agregan capas encima de las capas que ya tienen padres, mueva dicha capa con padres de 
nuevo a la parte superior de la pila de capas.
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Capítulo 13: Animación de un personaje Cut-out

Harmony ofrece herramientas muy útiles para animar modelos de personajes cut-out. Con la herramienta 
Transform (Transformar), puede mover las partes del personaje para crear poses clave, mientras que Harmony 
crea los intercalados. El tiempo del movimiento se puede ajustar para crear movimientos realistas y los dibujos 
de las partes del personaje se pueden intercambiar en cualquier punto de la animación, permitiendo combinar 
los cambios del movimiento y del dibujo para crear animaciones cut-out perfectamente ajustadas.

Creación de una animación Cut-out simple

Crearemos una animación Cut-out simple realizando la primera pose del personaje en el primer fotograma, 
la segunda pose en el siguiente fotograma y permitiendo que Harmony las interpole.

 1. En la vista de línea de tiempo, contraiga el personaje con la flecha Expand/Collapse 
(Expandir/Contraer).

 2. Seleccione el primer fotograma de la escena.

 3. Para garantizar que el modelo no desaparezca después de 1 fotograma, abra el cuadro de diálogo 
Extend Exposure (Extender exposición) realizando una de las siguientes acciones:

 l Haga clic con el botón derecho en el primer fotograma de la vista de línea de tiempo y 
seleccione Extend Exposure (Extender exposición).
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 l Pulse F5.

 4. En el cuadro de diálogo Extend Exposure (Extender exposición), escriba el número de fotogramas de 
la escena y confirme. De este modo, el modelo quedará expuesto (será visible) en toda la escena.

 5. Ahora crearemos la primera pose del personaje. En primer lugar, asegúrese de que haya un 
fotograma clave en el primer fotograma de cada capa del modelo. Con ello garantiza que cuando 
cree la segunda pose más tarde, la primera pose no se vea afectada. Para llevarlo a cabo, realice una 
de las siguientes acciones:

 l En la barra de herramientas Timeline (Línea de tiempo), haga clic en el botón Add 
Keyframe (Agregar fotograma clave) .

 l Haga clic con el botón derecho y seleccione Add Keyframe (Agregar fotograma clave).

 l Pulse F6.

Se agrega un fotograma clave al fotograma actual.

 6. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Transform 
(Transformar)  o pulse Mayús + T.

 7. En la barra de herramientas Tools (Herramientas), active el modo Animate (Animar) . Esto 
permite que la herramienta Transform (Transformar) afecte a la posición y al tamaño de una capa 
solo en el fotograma clave actual, mientras que, en caso contrario, afectaría a la posición y al tamaño 
de la capa en toda la escena.

 8. En la vista de cámara, seleccione las partes que desea animar. El cuadro de control de la herramienta 
Transform (Transformar) aparecerá alrededor de la capa seleccionada. Cada parte del cuadro de 
control de la herramienta Transform (Transformar) se puede usar para realizar distintos tipos de 
transformaciones:
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 9. Utilice la herramienta Transform (Transformar)  para rotar, sesgar, escalar o trasladar la selección 
a su nueva posición.

 10. Repítalo en otras partes del modelo del personaje hasta que la primera pose haya terminado.

 11. En la barra de herramientas Tools (Herramientas), active la función Onion Skin (Papel cebolla) .

 12. En la vista de línea de tiempo, seleccione el fotograma donde desee tener la segunda pose.

 13. Cree un fotograma clave para la segunda pose realizando una de las siguientes acciones:

 l En la barra de herramientas Timeline (Línea de tiempo), haga clic en el botón Add 
Keyframe (Agregar fotograma clave) .

 l Haga clic con el botón derecho y seleccione Add Keyframe (Agregar fotograma clave).

 l Pulse F6.

Aparece el segundo fotograma clave junto con una línea que va desde el primer fotograma clave al 
segundo fotograma clave. Esto indica que Harmony interpolará cada fotograma intercalado.

Si no aparece ninguna línea, significa que se ha creado el primer fotograma clave como un fotograma 
clave de Stop-motion. Para resolverlo, realice una de las siguientes acciones: 

 l Haga clic con el botón derecho en el primer fotograma clave y seleccione Set Motion 
Keyframe (Definir fotograma clave de movimiento).

 l Seleccione el primer fotograma clave y pulse Ctrl + K (Windows/Linux) o ⌘  + K (macOS).
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. Para asegurarse que los nuevos fotogramas clave se establezcan en Motion (Movimiento) de forma 
predeterminada, seleccione Animation (Animación) en el menú superior y asegúrese de que la 
opción Stop-Motion Keyframe (Fotograma clave de Stop-motion) no esté activada. 

NOTA

Cada fotograma clave puede ser un fotograma clave de movimiento o un fotograma 
clave de Stop-motion. Harmony interpola los fotogramas entre dos fotogramas clave si 
el primero de los dos fotogramas clave es un fotograma clave de movimiento.

 14. En la vista de cámara, cambie de nuevo la pose del personaje.

 15. Repita este proceso para todas las poses que desee agregar a la animación.

Ajuste de la velocidad de la animación

 1. En la vista de línea de tiempo, contraiga la jerarquía del modelo del personaje.

 2. Seleccione uno de los fotogramas clave de la animación. Como la jerarquía del modelo está contraída, 
se selecciona el fotograma clave en cada capa simultáneamente.

 3. Realice una de las siguientes acciones:

 l En la vista de línea de tiempo, haga clic con el botón derecho y seleccione Set Ease For 
Multiple Parameters (Definir velocidad para varios parámetros).
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 l En la barra de herramientas Timeline (Línea de tiempo), haga clic en el botón Set Ease 
For Multiple Parameters (Definir velocidad para varios parámetros) .

Se abre el cuadro de diálogo Set Ease For Multiple Parameters (Definir velocidad para varios 
parámetros).

 4. En el gráfico, tire del controlador de la curva Bézier para ajustar la velocidad de todas las funciones 
seleccionadas.

 5. Para aplicar estos parámetros de velocidad únicamente a un tipo de función determinado, como 
Rotation (Rotación) o Scale (Escala), en la sección Filters (Filtros), anule la selección de los tipos de 
función a los que no desee que se apliquen.

 l Motion (Movimiento): Aplica los parámetros de velocidad a las funciones Position X 
(Posición X), Position Y (Posición Y), Position Z (Posición Z) y 3D Path (Ruta 3D) 
seleccionadas.

 l Rotation (Rotación): Aplica los parámetros de velocidad a las funciones de ángulo 
seleccionadas.
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 l Scale (Escala): Aplica los parámetros de velocidad a las funciones de escala 
seleccionadas.

 l Skew (Sesgar): Aplica los parámetros de velocidad a las funciones de inclinación 
seleccionadas.

 l Morphing: Aplica los parámetros de velocidad a las funciones de velocidad de 
morphing seleccionadas. Tenga en cuenta que se aplica cuando la función Morphing 
Velocity (Velocidad de morphing) de la ventana Layer Properties (Propiedades de 
capa) no es la velocidad de morphing básica en la vista de propiedades de la 
herramienta.

 l Other (Otras): Aplica los parámetros de velocidad a todas las demás funciones 
seleccionadas, como todas las funciones creadas para animar parámetros de efecto.

 6. También puede ajustar la velocidad introduciendo valores en los campos Time Ratio (Tasa de 
tiempo) y Value Ratio (Tasa de valor). Los valores se calculan como un porcentaje.

 l En los campos Left Time Ratio (Tasa de tiempo izquierdo) y Right Time Ratio (Tasa de 
tiempo derecho), escriba el valor como porcentaje correspondiente al tiempo que 
desea que dure la velocidad. El valor debe estar entre el 0 % y el 100 %.

 l En los campos Left Value Ratio (Tasa de valor izquierdo) y Right Value Ratio (Tasa de 
valor derecho), escriba el valor como porcentaje correspondiente a la intensidad que 
desea que tenga la desaceleración. El valor debe estar entre el 0 % y el 100 %.

 l Si los valores Time Ratio (Tasa de tiempo) y Value Ratio (Tasa de valor) son iguales, el 
movimiento será lineal.

 7. Haga clic en uno de los siguientes botones:

 l Apply/Previous (Aplicar/anterior): Aplica los parámetros de velocidad a los fotogramas 
clave seleccionados y automáticamente se selecciona el fotograma clave anterior en la 
línea de tiempo.

 l Apply (Aplicar): Aplica los parámetros de velocidad a los fotogramas clave 
seleccionados.

 l Apply/Next (Aplicar/siguiente): Aplica los parámetros de velocidad a los fotogramas 
clave seleccionados y automáticamente se selecciona el fotograma clave siguiente en la 
línea de tiempo.

 l Close (Cerrar): Cierra el cuadro de diálogo. Si no ha aplicado las modificaciones, se 
cancelarán.
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NOTA

Si se selecciona un rango que contiene varios fotogramas clave, solo el primer fotograma clave 
seleccionado se verá afectado por la función Set Ease for Multiple Parameters (Definir velocidad 
para varios parámetros).

Desplazamiento por las capas
Dado que la animación cut-out normalmente implica modelos complejos con amplias jerarquías, aprender los 
atajos para desplazarse fácilmente entre las capas puede ahorrar mucho tiempo.

Un truco de gran utilidad para aprender es el comando Centre on Selection (Centrar en selección), junto con su 
atajo de teclado. Este comando permite desplazarse directamente a la capa seleccionada en la vista de línea de 
tiempo. Por lo tanto, puede usar la vista de cámara para seleccionar de forma visual la capa con la que desee 
trabajar y, a continuación, usar el atajo de Centre on Selection (Centrar en selección) para encontrar la capa en 
la vista de línea de tiempo, en lugar de revisar la estructura de la escena para localizarla.

Centrado en la selección actual en la vista de línea de tiempo

 1. En la vista de línea de tiempo, contraiga todas las capas.

 2. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Transform 
(Transformar) .

 3. En la vista de cámara, seleccione cualquier capa.

 4. Realice una de las siguientes acciones:

 l Haga clic en la pestaña de la vista de línea de tiempo para ajustar el centrado en la 
misma y, a continuación, pulse O.

 l En la barra de herramientas de la vista de línea de tiempo, haga clic en el botón Centre 
on Selection (Centrar en selección) .

La vista de línea de tiempo está ahora centrada en la capa seleccionada y todos sus padres se han 
expandido automáticamente.

Si desea usar el atajo de teclado con frecuencia, le puede parecer que es cansado tener que hacer clic en la 
pestaña de vista de línea de tiempo cada vez. Para resolverlo, puede habilitar la preferencia Focus On Mouse 
Enter (Centrarse en ratón). Ajustará el centrado en una vista en cuanto el cursor del ratón entre en ella y hará 
funcionales al instante todos los atajos de teclado de esta vista.
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Activación de la preferencia Focus On Mouse Enter (Centrarse en ratón)

 1. En el menú superior, vaya a Edit > Preferences (Editar > Preferencias) (Windows/Linux) o Harmony 
> Preferences (Harmony > Preferencias) (Mac OS X).

 2. Abra la pestaña General.

 3. En la sección Options (Opciones), active la casilla de verificación Focus On Mouse Enter (Centrarse 
en ratón).

 4. Haga clic en OK (Aceptar).

Los atajos de teclado para vistas específicas funcionarán en cuanto el cursor del ratón entre en la 
vista prevista.

Harmony también tiene comandos y atajos de teclado para cambiar rápidamente la selección de la capa 
seleccionada actualmente a su su padre, su hijo o uno de sus hermanos, permitiendo así el desplazamiento con 
rapidez por la jerarquía del personaje desde una capa a una de sus capas relacionadas.

Selección del padre o del hijo de la capa seleccionada

 1. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Transform 
(Transformar) .

 2. En la vista de propiedades de la herramienta Transform (Transformar), asegúrese de que esté 
desactivado el modo Peg Selection (Selección de peg) .

 3. En la vista de cámara o de línea de tiempo, seleccione una capa u objeto conectado a una jerarquía.

 4. Realice una de las siguientes acciones:

 l Seleccione Animation > Select Parent (Animación > Seleccionar padre) o pulse B para 
seleccionar la capa padre.

 l Seleccione Animation > Select Child (Animación > Seleccionar hijo) o pulse Mayús + B 
para seleccionar la capa hija.
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 l Seleccione Animation > Select Children (Animación > Seleccionar hijos) para 
seleccionar todas las capas hijas al mismo tiempo.

   

Selección de los hermanos de la capa seleccionada

 1. En la vista de línea de tiempo, seleccione una capa que tenga al menos un hermano y realice una de 
las siguientes acciones:

 l Para seleccionar el hermano previo de la familia, pulse /.

 l Para seleccionar el siguiente hermano de la familia, pulse la tecla de signo de 
interrogación (?).
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Capítulo 14: Uso de deformadores
Los deformadores permiten animar objetos y partes de un modelo de personaje mediante las deformaciones 
generadas por ordenador. Permite doblar o distorsionar los dibujos sin necesidad de volver a dibujarlos. Cuando 
se usa en una animación cut-out, puede ampliar notablemente una gama de movimientos y poses que un 
modelo de personaje pueda conseguir sin necesidad de haber dibujado ninguna de sus partes en diferentes 
poses, lo que supone un ahorro de tiempo y hace que la animación cut-out parezca mucho más natural con 
menos esfuerzo.

Los deformadores se pueden usar para deformar una única capa de dibujo o una jerarquía de capas, de manera 
que un solo deformador se puede usar para deformar lo que sea desde un prop hasta un rig de personaje 
completo. Se puede usar tanto en dibujos vectoriales como en dibujos de mapa de bits.

Los deformadores funcionan al crear un rig con ellos como padres del dibujo que desee deformar, crear una 
estructura de deformador y, a continuación, animarlo. Se puede realizar fácilmente con la herramienta Rigging 

.

Hay  dos tipos de deformadores disponibles en Harmony Advanced:

 l Hueso

 l Hueso para juego

NOTA

Harmony Premium también admite los deformadores de curva y de distorsión de envolvente, que 
ofrecen funciones de deformación ampliadas que no son compatibles con Harmony Advanced.

Deformador de huesos
La deformación de hueso permite crear una estructura similar al hueso en la que cada parte es sólida, pero las 
articulaciones son flexibles. Esto es sobre todo útil para la animación de los miembros de un personaje, como los 
brazos o las piernas, u otras partes que se puedan articular, como torsos o dedos. Por ejemplo, se puede utilizar 
una deformación de hueso para articular un brazo que está hecho de un solo dibujo, de modo que el brazo y el 
antebrazo se puedan mover de forma independiente, sin necesidad de dibujar la parte superior del brazo y el 
antebrazo en capas diferentes. Harmony deformará el dibujo para que parezca que está articulado. Las 
distintas partes de una deformación de hueso se pueden rotar alrededor de su articulación, extenderse y 
acortarse, proporcionándole las mismas capacidades que las articulaciones de animación en distintas capas, sin 
tener que preocuparse por la separación de piezas, puntos de pivote o recorte de contornos.
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Deformador de hueso para juego
La deformación de hueso para juego es parecida a la deformación de hueso. Permite crear una estructura similar 
al hueso en la que cada parte es sólida, pero las articulaciones son flexibles. Sin embargo, se optimiza para 
motores de juego como Unity. Por lo tanto, generalmente se usa para desarrollo de juegos y no en producciones 
animadas. A diferencia de las deformaciones de hueso, las deformaciones de hueso para juego no tienen  una 
propiedad de sesgo. Los pliegues de la articulación también parecen ligeramente más redondos.

Creación de deformadores
La manera más sencilla para crear deformadores es usar la herramienta Rigging , disponible en la barra de 
herramientas Deformation (Deformación). Con esta herramienta, todo lo que necesita hacer para crear un 
deformador es seleccionar la capa que desee deformar y, a continuación, colocar cada punto del deformador en 
la vista de cámara.
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Los deformadores existen en la escena como una jerarquía de capas de deformación. Cuando crea un nuevo 
deformador, el primer punto que define es la raíz del deformador y cada punto nuevo que crea es un hijo del 
punto anterior. Por lo tanto, los deformadores se crean en una cadena y se deben crear teniendo en cuenta la 
jerarquía del personaje. Por ejemplo, si crea un deformador para un brazo, la raíz debe ser la articulación del 
hombro, el segundo punto debe ser el codo y el tercero, la muñeca.

Selección del elemento en el que crear un deformador 

Un deformador afecta a todas las capas que hay debajo de su jerarquía. Al crear un nuevo deformador 
utilizando la herramienta rigging, se crea automáticamente como padre de la capa seleccionada, y afectará 
a la capa seleccionada y a todas sus hijas. Por lo tanto, es importante seleccionar la capa correcta antes de 
intentar crear un deformador.

Por ejemplo, si se desea crear un deformador para un brazo y el brazo se divide en varias capas, se puede 
crear un rig del brazo en una jerarquía donde el brazo superior sea la raíz, el antebrazo sea el hijo del brazo 
superior y la mano sea el hijo del antebrazo. A continuación, si crea su deformador en la parte superior del 
brazo, se creará como padre de la parte superior del brazo y, por lo tanto, afectará a todo el brazo.

También puede agrupar varias capas debajo de un peg y crear su deformador con este peg seleccionado. Al 
crear un deformador en un peg, el deformador se crea como un hijo del peg, pero como padre de todos los 
hijos de este peg. Esto se debe a que es probable que un peg sea más útil sobre un deformador que debajo. 
Si mueve las capas que están debajo un deformador, saldrán de la zona de deformación prevista y pueden 
aparecer muy deformadas y distorsionadas. Por lo tanto, es mejor crear todas las deformaciones posibles 
debajo de los pegs, y los pegs que estén debajo de los deformadores solo deben animarse si el deformador 
se queda intacto. Dado que el deformador se creará como padre de todos los hijos del peg, afectará a todas 
las capas que haya debajo de este.

Creación de un deformador de hueso o de hueso para juego

 1. Una vez seleccionado el elemento, seleccione la herramienta Rigging  en la barra de 
herramientas Deformation (Deformación).
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 2. En la vista de propiedades de la herramienta, habilite el modo Bone (Hueso)  o el modo Game 
Bone (Hueso para juego) , dependiendo de si el rigging es para un proyecto de animación o para 
un juego.

 3. Coloque el cursor en la raíz del dibujo o de la jerarquía de dibujo, haga clic una vez y suéltelo. Por 
ejemplo, si va a crear un deformador para todo el brazo, haga clic en la articulación del hombro.

 4. Mueva el cursor en la ubicación en la que desee que termine el primer hueso y que comience el 
segundo hueso, y haga clic de nuevo. Se insertará automáticamente un punto de control de 
articulación entre cada hueso que cree. 

 5. Mueva el cursor donde desee que se sitúe la siguiente articulación y haga clic para crear el siguiente 
punto.

Observe que, al crear un nuevo punto, el anterior aparece ahora rodeado por un círculo. Se trata del 
radio de la articulación, lo que permite determinar qué cantidad de dibujo debe formar parte de la 
articulación. Cada punto de un deformador de hueso, a excepción del primero y del último, cuenta 
con un punto de ajuste de radio.

 6. Haga clic y mantenga pulsado el manipulador del radio de la articulación anterior y ajuste el radio de 
la articulación de modo que cubra el miembro.
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 7. Repita el proceso hasta que haya terminado de crear la cadena de huesos. Asegúrese de crear cada 
articulación en el orden correcto desde la raíz hasta la extremidad.

Visualización de deformadores
Harmony permite controlar qué deformadores se muestran en la vista de cámara independientemente de la 
selección actual. Al crear una cadena de deformación, sus controles de deformación se muestran en la vista de 
cámara. Sin embargo, si selecciona un deformador existente o una capa que esté conectada a deformadores 
existentes, sus controles de deformación no se mostrarán inmediatamente. Asimismo, al desactivar una cadena 
de deformación no se ocultarán sus controles de deformación. Para poder animar o modificar una cadena de 
deformación existente, debe mostrarla de forma manual.

Visualización de los controles de deformación

 1. Realice una de las siguientes acciones:

   l En la vista de cámara o de línea de tiempo, seleccione uno de los elementos de dibujo 
vinculados a la cadena de deformación que desee visualizar.

 l En la vista de línea de tiempo, seleccione cualquier parte de la cadena de deformación 
que desee visualizar.

 2. En la barra de herramientas Deformation (Deformación), haga clic en el botón Show the Selected 
Deformation Chain and Hide All Others (Mostrar la cadena de deformación seleccionada y ocultar el 
resto) .

Los controles de deformación seleccionados aparecen en la vista de cámara y los demás quedan 
ocultos.

NOTA

El botón Show the Selected Deformation Chain and Hide All Others (Mostrar la cadena de 
deformación seleccionada y ocultar el resto) mostrará todas las cadenas de deformación que se 
encuentran en la jerarquía de la selección. Por ejemplo, si está seleccionado el peg maestro de 
un modelo de personaje, se mostrarán todas sus cadenas de deformación. Asimismo, si están 
seleccionadas varias capas vinculadas con distintas cadenas de deformación, se mostrarán 
todas sus cadenas de deformación.
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Cómo ocultar los controles de deformación

 1. Realice una de las siguientes acciones:

 l En la barra de herramientas Camera (Cámara), haga clic en el botón Hide All Controls 
(Ocultar todos los controles) .

 l En el menú superior, seleccione View > Hide All Controls (Ver > Ocultar todos los 
controles). 

 l Pulse Mayús + C.

 l Seleccione una capa que no esté vinculada a ningún deformador y haga clic en el botón 
Show the Selected Deformation Chain and Hide All Others (Mostrar la cadena de 
deformación seleccionada y ocultar el resto) .

Modificación de las cadenas de deformación existentes
A medida que intenta animar una deformación, o si necesita realizar cambios en los dibujos de una deformación, 
es posible que deba realizar ajustes en la cadena de deformación para que se adapte mejor a sus necesidades.

Adición de una articulación a una deformación de hueso o de hueso para juego 
existente

 1. Seleccione la capa de dibujo o la cadena de deformación a la que desea agregar una articulación.

 2. En la barra de herramientas Deformation (Deformación), haga clic en el botón Show the Selected 
Deformation Chain and Hide All Others (Mostrar la cadena de deformación seleccionada y ocultar el 
resto)  para mostrar los controles de deformación en la vista de cámara. De este modo, también se 
ocultan todos los controles de deformación visualizados.

 3. Seleccione la herramienta Rigging .

La cadena de deformación cambia de verde a rojo. Una cadena verde indica que está animando la 
deformación. Una cadena roja indica que está modificando el rig.

 4. Mueva el cursor sobre el segmento de hueso donde desea agregar una articulación.

 5. Mantenga pulsada la tecla Alt y haga clic.
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Realización de ajustes en los deformadores existentes 

 1. Seleccione la capa de dibujo o la cadena de deformación para la que necesita realizar ajustes.

 2. En la barra de herramientas Deformation (Deformación), haga clic en el botón Show the Selected 
Deformation Chain and Hide All Others (Mostrar la cadena de deformación seleccionada y ocultar el 
resto)  para mostrar los controles de deformación en la vista de cámara. De este modo, también se 
ocultan todos los controles de deformación visualizados.

 3. En la barra de herramientas Deformation (Deformación), haga clic en la herramienta Rigging .

La cadena de deformación cambia de verde a rojo. Una cadena verde indica que está animando la 
deformación. Una cadena roja indica que está modificando el rig.

 4. En la vista de cámara, configure la cadena de deformación.

 l Gire el primer hueso para cambiar el ángulo de la cadena.

 l Utilice el control raíz para cambiar de posición (desplazar) toda la cadena.
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 l Utilice puntos de control para cambiar de posición las articulaciones. De este modo se 
alargará, acortará o cambiará la dirección del hueso. Esto también desplazará los 
demás puntos de la cadena de deformación.

 l Utilice el control de la articulación (cuadrado) para cambiar el tamaño de la misma. Por 
motivos de calidad, se recomienda que el diámetro de la articulación se ajuste al de la 
parte que controla.
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 5. Repita el proceso hasta que todas las articulaciones y huesos de la cadena estén correctamente 
alineados con el elemento con el que están vinculados. 

NOTA

Al manipular la articulación de un hueso o hueso para juego, puede mantener pulsada la tecla 
Alt para bloquear el ángulo del hueso y solo acortar o alargar el hueso. También puede 
mantener pulsada la tecla Ctrl (Windows/Linux) o ⌘  (macOS) para romper la articulación de su 
cadena y transformarla en una nueva cadena de deformador independiente.

Animación con deformadores
Al igual que con los pegs de animación y las capas de dibujo, puede animar los deformadores creando 
fotogramas clave en sus capas correspondientes en la línea de tiempo. La animación de deformadores funciona 
exactamente igual que la realización de modificaciones en un deformador, excepto que requiere el uso de la 
herramienta Transform (Transformar)  en lugar de la herramienta Rigging. Al seleccionar la herramienta 
Transform (Transformar), los controles de deformación de la vista de cámara se muestran de color verde, lo que 
significa que se encuentran en modo de animación, mientras que cuando se selecciona la herramienta Rigging, 
se muestran en rojo, lo que significa que se encuentran en modo de rigging.

Animación de deformaciones de hueso y hueso para juego

 1. En la vista de línea de tiempo, contraiga el personaje con la flecha Expand/Collapse 
(Expandir/Contraer).

 2. Seleccione el primer fotograma de la escena.
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 3. Para garantizar que el modelo no desaparezca después de 1 fotograma, abra el cuadro de diálogo 
Extend Exposure (Extender exposición) realizando una de las siguientes acciones:

 l Haga clic con el botón derecho en el primer fotograma de la vista de línea de tiempo y 
seleccione Extend Exposure (Extender exposición).

 l Pulse F5.

 4. En el cuadro de diálogo Extend Exposure (Extender exposición), escriba el número de fotogramas de 
la escena y confirme. De este modo, el modelo quedará expuesto (será visible) en toda la escena.

 5. Ahora crearemos la primera pose del personaje. En primer lugar, asegúrese de que haya un 
fotograma clave en el primer fotograma de cada capa del modelo. Con ello garantiza que cuando 
cree la segunda pose más tarde, la primera pose no se vea afectada. Para llevarlo a cabo, realice una 
de las siguientes acciones:

 l En la barra de herramientas Timeline (Línea de tiempo), haga clic en el botón Add 
Keyframe (Agregar fotograma clave) .

 l Haga clic con el botón derecho y seleccione Add Keyframe (Agregar fotograma clave).

 l Pulse F6.

Se agrega un fotograma clave al fotograma actual.

 6. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Transform 
(Transformar)  o pulse Mayús + T.

 7. En la barra de herramientas Tools (Herramientas), active el modo Animate (Animar) . Esto 
permite que la herramienta Transform (Transformar) afecte a la posición y al tamaño de una capa 
solo en el fotograma clave actual, mientras que, en caso contrario, afectaría a la posición y al tamaño 
de la capa en toda la escena.

 8. Realice una de las siguientes acciones:

   l En la vista de cámara o de línea de tiempo, seleccione uno de los elementos de dibujo 
vinculados a la cadena de deformación que desee visualizar.

 l En la vista de línea de tiempo, seleccione cualquier parte de la cadena de deformación 
que desee visualizar.
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 9. En la barra de herramientas Deformation (Deformación), haga clic en el botón Show the Selected 
Deformation Chain and Hide All Others (Mostrar la cadena de deformación seleccionada y ocultar el 
resto) .

Los controles de deformación seleccionados aparecen en la vista de cámara y los demás quedan 
ocultos.

 10. En la vista de cámara, realice lo siguiente:

 l Gire el primer hueso para rotar el miembro.

 l Gire los demás huesos para doblar el miembro.

 l Utilice el control raíz para cambiar de posición (desplazar) toda la cadena.
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 l Utilice puntos de control para cambiar de posición las articulaciones. De este modo se 
alargará, acortará o cambiará la dirección del hueso, y se desplazarán los demás hijos.

 11. En la vista de línea de tiempo, vaya al fotograma en el que desee definir la siguiente pose clave.

 12. Agregue un fotograma clave en el fotograma actual realizando una de las siguientes acciones:

 l En la barra de herramientas Timeline (Línea de tiempo), haga clic en el botón Add 
Keyframe (Agregar fotograma clave) .

 l Haga clic con el botón derecho y seleccione Add Keyframe (Agregar fotograma clave).

 l Pulse F6.

 13. Transforme los puntos de la cadena de deformación para crear la nueva pose clave.

 14. Repita los pasos anteriores hasta que la animación haya terminado.

NOTA

Al manipular la articulación de un hueso o hueso para juego, puede mantener pulsada la tecla 
Alt para bloquear el ángulo del hueso y solo acortar o alargar el hueso. También puede 
mantener pulsada la tecla Ctrl (Windows/Linux) o ⌘  (macOS) para romper la articulación de su 
cadena y transformarla en una nueva cadena de deformador independiente.
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Capítulo 15: Importación de sonido y sincronización 
de labios

Importación de sonido
Si desea agregar sonido a la animación, se recomienda que edite y mezcle los archivos de sonido en un software 
de edición de sonido. Tener pistas de sonido completamente premezcladas garantiza que el sonido conserve su 
tiempo, mezcla y calidad si utiliza software de terceros para la postproducción. Otra buena práctica es mantener 
la pista de sonido separada en pistas de música, efectos de sonido y personajes para facilitar la sincronización 
de la animación con voces y sonidos. De lo contrario, es posible recortar los efectos de sonido y ajustar su 
volumen directamente en Harmony cuando sea necesario.

Si crea el proyecto en Toon Boom Storyboard Pro, puede exportar todas las escenas del proyecto como escenas 
separadas de Harmony. La pista de sonido del storyboard se cortará por escena y cada pieza se insertará en las 
escenas exportadas, lo que le permite ahorrar tiempo en la división e importación de la pista de sonido.

Harmony puede importar archivos de sonido .wav, .aiff y .mp3.

NOTA

La importación de una pista de sonido más larga que la escena no ampliará la longitud de esta 
última. La reproducción de sonido se detendrá al final de la duración de la escena.

Importación de un archivo de sonido

 1. Realice una de las siguientes acciones:

 l En el menú superior, seleccione File > Import > Sound (Archivo > Importar > Sonido).

 l En la vista de carta de rodaje, haga clic con el botón derecho en cualquier parte del 
área de fotogramas y seleccione Import > Sounds (Importar > Sonidos).

 l En el menú Xsheet (Carta de rodaje), seleccione File > Import > Sounds (Archivo > 
Importar > Sonidos).

 l En el menú Timeline (Línea de tiempo), seleccione Import > Sounds (Importar > 
Sonidos).

Se abre el cuadro de diálogo Select Sound File (Seleccionar archivo de sonido).
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 2. En el cuadro de diálogo Select Sound File (Seleccionar archivo de sonido), busque y seleccione un 
archivo de sonido.

El archivo de sonido aparece como una capa en la vista de línea de tiempo. Su forma de onda se 
muestra en la pista para ayudar a visualizar en qué fotogramas se producen los efectos de sonido de 
la pista de sonido.

La pista de sonido también aparece como una columna en la vista de carta de rodaje, pero no 
mostrará una forma de onda de forma predeterminada. Si lo desea, puede visualizar la forma de 
onda de una columna de sonido haciendo clic con el botón derecho en ella y seleccionando Sound 
Display > Waveform (Visualización de sonido > Forma de onda).

Detección automática de sincronización de labios
La adición de la sincronización de labios a la animación es fundamental para que parezca que los personajes 
están vivos. Sin embargo, también es una parte especialmente pesada del proceso de animación.

Para solucionar este problema, Harmony proporciona una función de detección automática de sincronización de 
labios. Esta función analiza el contenido de una pista de sonido de la escena y asocia cada fonema que detecta 
con una de las formas de boca de la siguiente carta de fonemas, que es una carta de fonemas estándar del 
sector de la animación.
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NOTA

Las letras asignadas a estas formas de boca son identificadores estándar y NO se corresponden con 
el sonido que se pretende producir.

Esta es una aproximación de los fonemas ingleses que cada forma de boca puede utilizar para representar:

 l A: m, b, p, h

 l B: s, d, j, i, k, t

 l C: e, a

 l D: A, E

 l E: o

 l F: u, oo

 l G: f, ph

 l X: silencio, sonido indeterminado

Al realizar la detección automática de sincronización de labios, Harmony no crea dibujos de boca. Simplemente 
rellena la columna de dibujo de la capa de la boca del personaje con la sincronización de labios generada, 
insertando la letra asociada con la forma de boca correcta en cada celda de la columna. Por lo tanto, para que la 
detección automática de sincronización de labios funcione, la capa de la boca del personaje ya debe contener un 
dibujo de boca para cada dibujo de la carta de fonemas, y estos dibujos deben tener el nombre de su letra 
correspondiente.

Generación de una detección de sonido para sincronización de labios mediante la vista 
de propiedades de capa

 1. En la vista de línea de tiempo o de carta de rodaje, seleccione la capa de sonido.
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Las opciones para dicha capa aparecerán en la vista de propiedades de capa.

 2. En las propiedades de capa, haga clic en Detect (Detectar).

Harmony analiza los clips de sonido seleccionados y asigna una letra de sincronización de labios a 
cada celda de sonido.

 3. Haga clic en el botón Map (Asignar) para abrir el cuadro de diálogo Lip-Sync Mapping (Asignación 
de sincronización de labios).

 4. En el menú Destination Layer (Capa de destino), seleccione la capa que contiene las posiciones de la 
boca para la pista de voz del personaje.
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NOTA

Si la capa seleccionada contiene símbolos, puede asignar la sincronización de labios 
utilizando dibujos situados directamente en la capa o bien utilizar los fotogramas del 
símbolo. En el campo Symbol Layer (Capa de símbolos), seleccione Don't Use Any 
Symbol (No usar ningún símbolo) si desea utilizar los dibujos o seleccionar el símbolo 
deseado del menú desplegable.

 5. En la sección Mapping (Asignación), escriba el nombre del dibujo o los fotogramas del símbolo en el 
campo situado a la derecha del fonema que representa. Si los dibujos ya tienen los nombres de las 
letras del fonema, puede saltarse este paso.

 6. Haga clic en OK (Aceptar).

 7. En la barra de herramientas Playback (Reproducir), habilite la opción Enable Sound (Habilitar 
sonido) .

 8. Pulse el botón Play (Reproducir)  en la barra de herramientas Playback (Reproducir) para ver y oír 
los resultados en la vista de cámara.

Si tiene que realizar ajustes a la sincronización de labios generada automáticamente, consulte 
Animación manual de sincronización de labios en la página 122.

Animación manual de sincronización de labios
Puede crear la sincronización de labios para la escena de forma manual seleccionando qué dibujo de boca debe 
exponerse en cada fotograma del cuadro del diálogo de su personaje. Para este proceso, utilizará la función 
Sound Scrubbing (Depuración de sonido), que reproduce la parte de la pista de sonido en el fotograma actual 
cada vez que mueva el cursor de la línea de tiempo, lo que le permite identificar los fonemas que debe hacer 
coincidir con la boca de su personaje. También se utilizará un dibujo de sustitución para cambiar el dibujo de la 
boca que se expone en cada fotograma.

Animación de sincronización de labios utilizando la vista de línea de tiempo

 1. En la barra de herramientas Playback (Reproducir), haga clic en el botón Sound Scrubbing 
(Depuración de sonido) .

 2. En la vista de línea de tiempo, arrastre el cabezal de reproducción rojo a lo largo de la forma de onda 
de la capa de sonido.

 3. Cuando llegue a un fotograma en el que deba ir una posición determinada de la boca, por ejemplo, 
una boca abierta con labios redondeados para un sonido como "oh", haga clic en ese fotograma en la 
capa de formas de boca.
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 4. En la sección Parameters (Parámetros), y continuando en la capa de formas de boca, coloque el 
cursor en la parte superior del nombre del dibujo (normalmente una letra) hasta que cambie al 
puntero de intercambio .

 5. Arrastre el cursor para ver la lista de los nombres de la forma de la boca y elija la que desee. El dibujo 
actual se cambia automáticamente a la nueva selección.

Animación de sincronización de labios utilizando la vista de librería

 1. En la barra de herramientas Playback (Reproducir), haga clic el botón Sound Scrubbing (Depuración 
de sonido)  .

 2. En la vista de línea de tiempo, arrastre el cabezal de reproducción rojo a lo largo de la forma de onda 
de la capa de sonido.

 3. Cuando llegue a un fotograma en el que deba ir una posición determinada de la boca, por ejemplo, 
una boca abierta con labios redondeados para un sonido como "oh", haga clic en ese fotograma en la 
capa de formas de boca.

 4. En la ventana Drawing Substitution (Sustitución de dibujo) de la vista de librería, arrastre el control 
para elegir una forma de boca. El dibujo actual se intercambia por el de la ventana de 
previsualización.
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Capítulo 16: Adición de efectos a una escena
Al crear una escena, crear un rig de personaje o una vez que la animación esté terminada, puede agregar 
efectos, como desenfoques, brillos, sobras, filtros de color y de transparencia, así como mejorar la calidad del 
proyecto. Los efectos cambian la forma en la que las capas o grupos de capas se renderizan en la escena.

Acerca de los efectos
Los efectos son tipos de capas especiales que se pueden agregar a la estructura de la escena. Para que una capa 
de efecto funcione, debe estar conectada como hija de un dibujo, grupo u otro efecto. Los efectos solo se aplican 
al elemento al que están conectados. Esto proporciona flexibilidad a la hora de decidir a qué elementos de la 
escena afecta un efecto.

Algunos efectos necesitan vincularse a otra capa, denominada capa de mate, que se usa para definir el área a la 
que deben afectar.  Un buen ejemplo de ello es el efecto de tono, que se usa para agregar una sombra de una 
forma determinada a una capa. De forma independiente, el efecto de tono no tienen ningún impacto en el 
dibujo al que está conectado. Una vez combinado con una capa de mate, el efecto de tono usará la forma del 
mate para aplicar una sombra al dibujo. Incluso si la forma del mate sale fuera de los contornos del dibujo, la 
sombra solo se aplicará dentro de los contornos del dibujo. 

124



Una capa de mate es una capa de dibujo habitual que está conectada a un efecto como su mate. El efecto toma 
la forma del dibujo en la capa de mate e ignora sus colores y detalles para determinar el área de la imagen a la 
que debe afectar.

En la vista de línea de tiempo, se debe crear un rig de un efecto como el hijo de una capa de dibujo o grupo al 
que debe afectar. Si el efecto puede usar una capa de mate, tendrá un parámetro de mate al ampliar la lista de 
parámetros. Puede arrastrar y colocar la capa en la que desee usar un mate para el efecto en el parámetro de 
mate del efecto para vincularlos.

Una vez que el efecto está conectado, puede ajustar sus parámetros en la vista de propiedades de capa. Si se 
desea, incluso puede animar los parámetros del efecto convirtiendo sus valores a funciones.

Adición de un efecto
En Harmony, puede agregar efectos seleccionando la capa o grupo al que desee agregar un efecto y, a 
continuación, agregando el efecto a través del menú Add Layers (Agregar capas) de la vista de línea de tiempo. 
A continuación, puede conseguir el efecto previsto ajustando los parámetros en la vista de propiedades de capa 
y conectándolos a una capa de mate, según proceda.

Adición de efectos en la vista de línea de tiempo

 1. En la vista de línea de tiempo, seleccione la capa en la que desee agregar un efecto.

 2. Realice una de las siguientes acciones:

 l En el menú superior, seleccione Insert > Effects > effect (Insertar > Efectos > efecto).

 l En la barra de herramientas Layers (Capas), haga clic en el botón Add Layers (Agregar 
capas)  y seleccione Effects > effect (Efectos > efecto).

 l Haga clic con el botón derecho en la capa y, a continuación, seleccione Insert > Effects 
> effect (Insertar > Efectos > efecto).

El efecto aparece en la vista de línea de tiempo.

 

 3. En la vista de cámara, haga clic en el botón Render View (Vista de render)  para ver el fotograma 
y el efecto actuales renderizados de la escena. Tenga en cuenta que la mayoría de los efectos no se 
pueden reproducir en tiempo real. Debe usar la opción Render and Play (Renderizar y reproducir)
de la barra de herramientas Playback (Reproducir).
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NOTA

El fondo aparecerá en negro de forma predeterminada. Para corregirlo, puede 
agregar una capa de la carta de color en la parte inferior de la lista de capas y 
cambiar su color en la vista de propiedades de capa.

 4. En la vista de línea de tiempo, haga doble clic en la capa del efecto para abrir la ventana Layer 
Properties (Propiedades de capa). También puede seleccionar la capa del efecto y ver sus 
propiedades en la vista de propiedades de capa.

Se abre la vista de propiedades de capa y muestra los parámetros disponibles para el efecto 
seleccionado.

 5. En la vista de propiedades de capa, ajuste los parámetros del efecto según sea necesario. Cada vez 
que realice un cambio, la vista de cámara tendrá que actualizar el render, lo cual puede provocar una 
ligera demora antes de que pueda observar el efecto.

 6. Para reproducir la escena con los efectos finales, haga clic en el botón Render and Play (Renderizar 
y reproducir)  en la barra de herramientas Playblack (Reproducir).

NOTA

Una vez que haya establecido los parámetros para el efecto, puede almacenarlo en la vista de 
librería como plantilla para poder reutilizarlo rápidamente sin necesidad de restablecer los 
parámetros de nuevo; consulte Creación y uso de plantillas en la página 144.

 Adición de un efecto con un mate
El siguiente tutorial muestra como usar el efecto de cuchilla con un mate. En Harmony, varios efectos usan mates 
para determinar el área de la imagen a la que afectan.
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El efecto de cuchilla permite cortar una parte de una imagen. Para ello, debe conectarse al dibujo que se 
pretende cortar, así como a una capa de mate. La cuchilla adoptará la forma del dibujo de la capa de mate y 
cortará esta forma de la capa de dibujo. Esto es especialmente útil si desea que un personaje desaparezca entre 
un elemento de fondo o si desea realizar un agujero en el centro de un personaje.

Al igual que todos los efectos que utilizan un mate, el efecto de cuchilla tiene un parámetro Inverted (Invertido), 
que está deshabilitado de forma predeterminada. Cuando esté habilitada, la cuchilla tendrá el efecto contrario: 
en lugar de cortar la forma del mate del dibujo, cortará todo lo que se encuentre fuera de la forma del mate del 
dibujo, dejando solo las partes del dibujo que estén cubiertas por el mate. 

Uso del efecto de cuchilla

 1. Seleccione una capa de dibujo.

 2. Haga clic en el botón Add Layers (Agregar capas)  y seleccione Effects > Cutter (Efectos > 
Cuchilla).

El efecto de cuchilla se crea como capa hija de la capa seleccionada.

 3. En la vista de línea de tiempo, cree una nueva capa, que se utilizará como la capa de mate del efecto 
de cuchilla.

 4. En la nueva capa de mate, dibuje la forma que desee cortar de la capa de dibujo.

 5. En la vista de línea de tiempo, haga clic en el botón Collapse/Expand (Contraer/expandir)  de la 
capa del efecto para mostrar su parámetro de mate.
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 6. Arrastre y coloque la capa de mate junto al campo Matte (Mate) de la capa de Cutter (Cuchilla), 
debajo de la columna Parameters (Parámetros).

 7. Si desea invertir el efecto de cuchilla, haga doble clic en la capa Cutter (Cuchilla) para abrir el cuadro 
de diálogo Layer Properties (Propiedades de capa) y, a continuación, habilite la opción Inverted 
(Invertido).

NOTA

Si solo necesita aplicar un mate a una sola capa de dibujo, puede vincular este mate a la propia 
conexión de mate de la capa de dibujo. Cada capa de dibujo tiene su propia conexión de mate, 
que puede actuar como una cuchilla individual si está conectada a otra capa de dibujo. 

Otros dos ejemplos de efectos que funcionan con mates son los efectos de tono y resaltado. El efecto de tono 
aplica una sombra a su dibujo basada en su mate, mientras que el efecto de resaltado aplica un resaltado a un 
dibujo basado en un mate. Estos efectos no se aplican fuera de los dibujos a los que están conectados, de modo 
que solo tiene que dibujar los resaltados y la sombra del personaje en las capas de mate sin preocuparse por 
dibujar fuera del trazado.
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La adición de estos efectos a un dibujo funciona exactamente igual que la adición de una cuchilla a un dibujo, 
salvo que tienen parámetros adicionales para configurar el color, la intensidad y el renderizado del efecto.

Animación de un efecto
En algunos casos, puede que desee tener la intensidad, el color u otro parámetro de un efecto animado. Por 
ejemplo, puede que aplicar un fundido de entrada o de salida a un objeto. Para llevarlo a cabo, tendría que 
conectarlo a un efecto de transparencia y animar el nivel de transparencia del efecto, de modo que aumente o 
disminuya al reproducir la escena. Puede animar el parámetro de un efecto creando una curva de función para 
dicho parámetro. A continuación, puede agregar fotogramas clave a la función y definirlos en distintos valores, 
consiguiendo así que el parámetro del efecto cambie el valor progresivamente al reproducir la escena. A fin de 
crear una función para el parámetro de un efecto, tendrá que usar la vista de propiedades de capa.

Animación de un efecto

 1. En la vista de línea de tiempo, seleccione una capa y agréguele un efecto realizando una de las 
siguientes acciones:

 l Haga clic en el botón Add Layer (Agregar capa)  y seleccione Effects > desired 
effect (Efectos > efecto deseado).

 l Haca clic con el botón derecho y seleccione Insert > Effects > desired effect (Insertar > 
Efectos > efecto deseado).

 l En el menú superior, seleccione Insert > Effects > desired effect (Insertar > Efectos > 
efecto deseado).
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 2. Cree la curva de función realizando una de las siguientes acciones:

 l Haga doble clic en la capa de efecto para mostrar las propiedades del mismo. Haga clic 
en el botón Function (Función)  del parámetro que desee animar y cree una curva de 
función.

 l En la vista de línea de tiempo, expanda los parámetros de la capa del efecto haciendo 
clic en el botón Collapse/Expand (Contraer/expandir) . A continuación, haga clic en 
el botón Function (Función)  del parámetro que desee animar y cree una curva de 
función.

 3. En la vista de línea de tiempo, vaya al fotograma en el que desea comenzar a animar el efecto.

 4. En la barra de herramientas Timeline (Línea de tiempo), agregue un fotograma clave a la función 
realizando una de las siguientes acciones:
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 l En la barra de herramientas Timeline (Línea de tiempo), haga clic en el botón Add 
Keyframe (Agregar fotograma clave) .

 l Haga clic con el botón derecho y seleccione Add Keyframe (Agregar fotograma clave).

 l Pulse F6.

 5. En el campo Value (Valor) del parámetro que desee animar, introduzca el valor que desee que tenga 
el parámetro en este fotograma clave.

 6. Repita estos pasos hasta que haya terminado la animación del efecto.

Creación de un efecto basado en un personaje animado
En el siguiente tutorial se demuestra cómo combinar efectos con otras funciones de Harmony para crear 
fácilmente una sombra paralela para un personaje animado. Siguiendo estos pasos, puede crear una sombra 
paralela que seguirá automáticamente la animación del personaje, incluso si después cambia la animación.

Creación de una sombra paralela para un personaje animado

 1. En la vista de línea de tiempo, seleccione todas las capas que forman el rig de personaje. Si el 
personaje está bajo un peg maestro, también funcionará si selecciona el peg maestro.

 2. Asegúrese de que el rig de personaje se encuentre en un grupo. De no ser así, haga clic con el botón 
derecho en la selección y, a continuación, seleccione Group Selection (Selección de grupo).
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 3. Una vez seleccionado el personaje en la vista de línea de tiempo, cree un clon del personaje 
realizando una de las siguientes acciones:

 l Haga clic con el botón derecho en la selección y, a continuación, seleccione Clone 
Selected Layers: Drawings and Timing (Clonar capas seleccionadas: Dibujos y tiempo).

 l En el menú superior, seleccione Edit > Clone: Drawings and Timing 
(Editar > Clonar: Dibujos y tiempo).

NOTA

Al contrario que un duplicado, una capa clonada siempre tiene el mismo tiempo y la 
misma exposición que su capa de origen, incluso si su capa de origen se cambia más 
tarde. Por lo tanto, puede cambiar la animación del personaje y la animación del 
personaje clonado se actualizará automáticamente con estos cambios.

 4. Agregue un efecto de sombra al grupo realizando una de las siguientes acciones.

 l En la barra de herramientas de capas de la vista de línea de tiempo, haga clic en Add 
Layers (Agregar capas) y seleccione Effects > Shadow (Efectos > Sombra).

 l Haga clic con el botón derecho en la selección y, a continuación, seleccione Insert > 
Effects > Shadow (Insertar > Efectos > Sombra).

 5. En la vista de línea de tiempo, seleccione la capa raíz del clon del personaje.

 6. Cree un peg padre para el clon realizando una de las siguientes acciones:
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 l En la barra de herramientas de capas de la vista de línea de tiempo, haga clic en el 
botón Add Peg (Agregar peg) .

 l Pulse Ctrl + P (Windows/Linux) o ⌘  + P (macOS).

 7. En la vista de línea de tiempo, seleccione el peg padre del clon.

 8. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Transform 
(Transformar) .

 9. En la vista de cámara, escale y sesgue el clon de modo que parezca una sombra difuminada.
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Capítulo 17: Uso de guías de dibujo
Cuando tenga que dibujar fondos u objetos con numerosas líneas rectas, ángulos en escuadra y perspectivas, 
puede usar las guías de dibujo para que le ayuden. Las guías agregan una línea de horizonte, así como puntos 
de fuga al espacio del dibujo, que se pueden mover para adaptar las necesidades de la escena y bloquean las 
herramientas de dibujo para que siempre dibujen líneas rectas, bien desde uno de los puntos de fuga, o bien 
hacia el eje horizontal o vertical de la guía.

Harmony admite los siguientes tipos de guías de dibujo:

 l Una guía de Cuadrícula cuadrada simplemente le ayuda a dibujar en los ejes horizontales y verticales, 
que son relativos a la línea del horizonte.

 l Una guía de Perspectiva con 1 punto le ayuda a dibujar líneas procedentes de un único punto de fuga, 
que se sitúa en el centro del horizonte de forma predeterminada. También le ayuda a dibujar a lo largo de 
los ejes horizontales y verticales. Esto puede ayudar a crear fondos realistas con edificios, paredes y 
objetos situados enfrente de la cámara.

 l Una guía de Perspectiva con 2 puntos le ayuda a dibujar líneas procedentes de uno de los dos puntos de 
fuga situados a la izquierda y a la derecha del espacio de dibujo. Esto puede ayudar a crear fondos 
realistas con edificios, paredes y objetos situados en un ángulo de la cámara.
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 l Una guía de Perspectiva con 3 puntos le ayuda a dibujar líneas procedentes de uno de los 3 puntos de 
fuga: dos puntos de fuga horizontales situados a la izquierda y a la derecha del espacio de dibujo, y un 
punto de fuga vertical situado debajo o encima del espacio de dibujo. Esto puede ayudarle a crear fondos 
realistas desde un ángulo bajo o alto. La guía de perspectiva con 3 puntos tiene dos valores predefinidos: 
el plano cenital y el plano nadir, que se pueden utilizar para perspectivas de ángulo alto y de ángulo bajo, 
respectivamente.

Para usar una guía de dibujo, en primer lugar debe agregarla a la lista de guías de la escena.

Adición de una guía de dibujo a la escena

 1. En el menú superior, seleccione Windows > Guides (Ventanas > Guías) para agregar la vista de 
guías al espacio de trabajo actual.

 2. En la vista de guías, seleccione el botón New Guide (Nueva guía)  y elija uno de los siguientes 
tipos de guías:

 l  Cuadrícula cuadrada

 l  Perspectiva con 1 punto

 l  Perspectiva con 2 puntos

 l  Perspectiva con 3 puntos (plano cenital)
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 l  Perspectiva con 3 puntos (plano nadir)

La nueva guía aparece en la lista de la vista de guías.

 3. Para agregar otra guía, repita el paso anterior.

Edición de una guía de dibujo

 1. En la vista de línea de tiempo o de carta de rodaje, seleccione un dibujo o una celda vacía, y cree un 
nuevo dibujo realizando una de las siguientes acciones:

 l Haga clic con el botón derecho en la celda y seleccione Drawing > Create Empty Drawing 
(Dibujo > Crear dibujo vacío).

 l Pulse Alt + Mayús + R.

 2. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Brush (Pincel) , 
Pencil (Lápiz) , Stroke (Línea vectorial transparente)  o Line (Línea) .

 3. En la vista de guías, seleccione una guía para convertirla en la guía activa.

Una vez que la guía esté activa, su línea del horizonte y sus puntos de fuga aparecen en el área de 
dibujo.
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 4. En la vista de guías, asegúrese de que la opción Lock Guide (Bloquear guía)  está deshabilitada. 
Con ello garantiza que puede editar la guía activa. 

 5. En el área de dibujo, aleje el zoom hasta que todos los puntos de fuga sean visibles (si fuera 
necesario).

 6. En el área de dibujo, agarre el horizonte o un punto de fuga y muévalo hasta la ubicación deseada.

Al usar la guía de cuadrícula cuadrada o la de perspectiva con 1 punto, el ángulo del horizonte se 
puede modificar al manipular la propia línea del horizonte.

Al usar la guía de perspectiva con 2 puntos o la de con 3 puntos, el ángulo del horizonte se puede 
modificar al manipular uno de los dos puntos de fuga del horizonte.
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Al ajustar la línea del horizonte, puede mantener pulsada la tecla Mayús para que la línea del 
horizonte se ajuste a cada 15 grados. Así es fácil mantener un horizonte totalmente horizontal.

NOTA

Cada modificación a una guía se puede deshacer con el comando Undo (Deshacer).

Dibujo con guías de dibujo

 1. En la vista de línea de tiempo o de carta de rodaje, seleccione un dibujo o una celda vacía, y cree un 
nuevo dibujo realizando una de las siguientes acciones:

 l Haga clic con el botón derecho en la celda y seleccione Drawing > Create Empty Drawing 
(Dibujo > Crear dibujo vacío).

 l Pulse Alt + Mayús + R.

 2. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Brush (Pincel) , 
Pencil (Lápiz) , Stroke (Línea vectorial transparente)  o Line (Línea) .

 3. En la vista de guías, seleccione la guía que desee usar.

 4. En el área de dibujo, dibuje una línea vectorial transparente con la herramienta de dibujo actual. 
Desde el gesto inicial, la herramienta se bloquea en uno de los ejes de la guía y lo fuerza a dibujar una 
línea recta que siga al eje.
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Capítulo 18: Creación de un multiplano
En la acción en vivo, cuando la cámara se mueva alrededor de una escena, parecerá que los objetos cercanos a la 
cámara se desplazan a una distancia mayor que los objetos alejados de la misma. En la animación 2D, se puede 
conseguir un efecto similar creando un multiplano.

En Harmony, puede configurar fácilmente un multiplano creando un fondo sobre varias capas, extendiéndolas 
en el eje Z para agregar profundidad y moviendo la cámara por el entorno resultante para crear una ilusión de 
perspectiva impresionante.

En el siguiente ejemplo, el fondo se compone de 6 capas diferentes y cada una representa un objeto que se 
encuentra a una distancia diferente de la cámara. A la izquierda, puede ver cómo se sitúa cada objeto en 
relación con la cámara, como si el espectador estuviera mirándolos desde un lado. A la derecha, puede ver cómo 
se sitúan las capas unas respecto a otras, como si el espectador estuviera mirando la escena desde una esquina. 
A continuación, puede ver la escena desde el punto de vista de la cámara.
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Mediante la herramienta Maintain Size (Mantener tamaño), puede convertir fácilmente un fondo multicapa 
normal en un multiplano. Esta herramienta permite mover una capa más cerca o más lejos de la cámara mientras 
se ajusta automáticamente el tamaño de la capa proporcionalmente a su distancia de la cámara, conservando su 
tamaño aparente desde el punto de vista de la cámara. Por lo tanto, no tiene que preocuparse por el tamaño y 
la posición de las capas al diseñar el fondo.

En una nueva escena de Harmony, dibuje los distintos elementos de un fondo en capas separadas. Siga los 
pasos que se muestran a continuación para convertir el fondo en un multiplano.

Configuración de un multiplano con la herramienta Maintain Size (Mantener tamaño)

 1. Asegúrese de que la opción No Z Dragging (No arrastrar en Z) del menú superior Animation 
(Animación) esté deshabilitada.

 2. Realice una de las siguientes acciones:

 l En la barra de herramientas Advanced Animation (Animación avanzada), seleccione la 
herramienta Maintain Size (Mantener tamaño) .

 l En el menú superior, seleccione Animation > Tools > Maintain Size (Animación > 
Herramientas > Mantener tamaño).
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 l Pulse Alt + 6.

 3. En la vista lateral o superior, seleccione una de las capas de la sección de imágenes miniatura. 
También puede seleccionar una capa en la vista de línea de tiempo.

La capa seleccionada se resalta en las vistas superior, lateral y de cámara.

 4. Arrastre la capa a lo largo del eje Z dentro del cono de cámara.

El elemento se moverá en el eje Z de la escena, pero mantendrá el mismo tamaño aparente en la 
vista de cámara.

Puede ver el multiplano desde distintos puntos de vista mediante la vista de perspectiva.

Visualización del multiplano en la vista de perspectiva

 1. Habilite la vista de perspectiva realizando una de las siguientes acciones:

 l Haga clic en el botón Add view (Agregar vista)  situado junto a las pestañas de las 
vistas de cámara y de dibujo y seleccione Perspective (Perspectiva).

 l En el menú superior, seleccione Windows > Perspective (Ventanas > Perspectiva).

 2. Para rotar la vista de perspectiva en las 3 dimensiones, mantenga pulsada la tecla Ctrl + Mayús 
(Windows/Linux) o ⌘  + mayúsculas (macOS) y, a continuación, haga clic y arrastre.
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Capítulo 19: Creación y uso de plantillas
Puede crear una plantilla a partir de una capa o de celdas. Puede almacenar como una plantilla cualquier 
elemento disponible en la vista de línea de tiempo.

Creación de una plantilla

Creación de una plantilla

 1. En la vista de línea de tiempo, seleccione varias celdas o capas.

Puede crear una plantilla a partir de una jerarquía de capas entera contrayendo la jerarquía y 
seleccionando su capa raíz. Esto puede ser útil para crear plantillas basadas en rigs de personajes o 
fondos de escena.

 2. En la vista de librería, seleccione una carpeta para almacenar la plantilla. De forma predeterminada, 
tendrá una librería denominada Librería de Harmony Advanced almacenada en el ordenador, en la 
subcarpeta Librería de Toon Boom Harmony Advanced de la carpeta Documentos.

 3. Si la carpeta de librería está bloqueada , haga clic con el botón derecho y seleccione Right to 
Modify (Derecho para modificar).

 4. Arrastre la selección a la carpeta de la librería elegida.

 5. En el cuadro de diálogo Rename (Cambiar nombre), asigne un nombre a la nueva plantilla.

 6. Haga clic en OK (Aceptar).
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NOTA

Si crea una plantilla seleccionando capas en la lista de capas de la vista de línea de tiempo, la 
plantilla incluirá la capa, así como todos los dibujos que contenga, incluso los dibujos que no se 
expongan en la línea de tiempo de la escena, mientras que la creación de una plantilla mediante la 
selección de celdas específicas en la línea de tiempo solo almacenará los dibujos seleccionados en la 
plantilla.

NOTA

Para cambiar el nombre de una plantilla una vez creada, haga clic con el botón derecho en el 
símbolo y seleccione Rename (Cambiar nombre).

Importación de una plantilla

Importación de una plantilla

 1. En la vista de librería, seleccione la plantilla que desea importar.

 2. Arrastre la plantilla seleccionada a la vista de cámara o a la izquierda de la vista de línea de tiempo.

Si coloca la plantilla en la vista de cámara, sus capas se agregarán en la parte superior de la lista de 
capas. Si coloca una plantilla en la lista de capas de la vista de línea de tiempo, se insertará entre las 
capas en las que la colocó.

Si la plantilla tiene la misma estructura de capas que una parte de la escena, puede colocarla 
directamente en los fotogramas del lado derecho de la vista de línea de tiempo. En lugar de insertar 
nuevas capas en la escena, esta acción reemplazará los dibujos y los fotogramas clave de la escena 
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por los de la plantilla. Esto es útil para importar plantillas de pose o animación para los personajes 
que ya se encuentran en la escena.
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Capítulo 20: Exportación de una película
Mediante el cuadro de diálogo Export Movie (Exportar película), puede exportar la animación como un archivo 
de vídeo. Harmony exportará toda la escena a resolución completa de forma predeterminada. Si lo prefiere, 
puede elegir exportar solo un rango de fotogramas específico en la escena o exportarlo a menor resolución, lo 
cual puede ser útil si necesita ahorrar tiempo o espacio en disco.

Si tiene requisitos específicos para la calidad y el tamaño de los archivos de vídeo exportados, puede utilizar el 
cuadro de diálogo Movie Options (Opciones de película) para configurar la compresión del vídeo y del sonido. Si 
va a exportar una película de QuickTime, tiene acceso a todos los códecs y configuraciones de compresión 
disponibles en la interfaz de QuickTime.

NOTA

En Windows, puede exportar películas en formato Windows Media Video de forma 
predeterminada o en formato de película de QuickTime, si QuickTime está instalado. En macOS y 
Linux solo puede exportar en formato de película de QuickTime.

Exportación de un archivo de película

 1. En el menú superior, seleccione File > Export > Movie (Archivo > Exportar > Película).

Se abre el cuadro de diálogo Export to QuickTime Movie (Exportar a película de QuickTime).

 2. En el menú desplegable Video Format (Formato de vídeo), seleccione el formato deseado para el 
archivo de película:
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 l Quick Time Movie (*.mov): Disponible de forma predeterminada en macOs y Linux, así 
como en Windows si QuickTime está instalado.

 l Windows Media Video (*.wmv): Disponible solamente en Windows. No es necesario 
que QuickTime esté instalado.

 3. Haga clic en Browse (Examinar) para seleccionar la ubicación y el nombre de archivo del archivo de 
película exportado.

 4. Haga clic en OK (Aceptar).

 5. En la sección Export Range (Rango de exportación), decida si desea exportar toda la escena (All 
(Todo)) o un intervalo de fotogramas específico. Si decide lo último, introduzca un rango de 
fotogramas.

 6. En la sección Resolution (Resolución), seleccione una de las siguientes opciones en el menú:

 l Una relación de resolución preferida.

 l Custom (Personalizado): Activa los campos Width (Anchura) y Height (Altura) para 
que pueda introducir un tamaño específico.

 7. En la sección Options (Opciones), haga clic en Movie Options (Opciones de película) para configurar 
la compresión del vídeo y del sonido de la película.

Si el formato del vídeo es Quick Time Movie, consulte las secciones Exportación de una película de 
QuickTime sin pérdidas con transparencia en la página 150 y Configuración de ajustes de vídeo y 
sonido para películas de QuickTime en la página 151. Si el formato del vídeo es Windows Media 
Video, consulte la sección Configuración de ajustes de vídeo y sonido para Windows Media Video en 
la página 154.

 8. Haga clic en OK (Aceptar).
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Capítulo 20: Exportación de una película

 9. En el cuadro de diálogo Export to QuickTime Movie (Exportar a película de QuickTime), haga clic en 
OK (Aceptar).

Aparece una barra de progreso.

 10. Desplácese a la ubicación en el ordenador en la que ha exportado la película y haga doble clic en ella 
para verla en el reproductor de vídeo.

Exportación de una película de QuickTime sin pérdidas con transparencia

 1. En la sección Video (Vídeo) del cuadro de diálogo Movie Settings (Configuración de película), 
seleccione Settings (Configuración).

 2. En el cuadro de diálogo Standard Video Compression Settings (Configuración de compresión de 
vídeo estándar), establezca Compression Type (Tipo de compresión) en Animation (Animación).

 3. En la sección Compressor (Compresor), establezca Depth (Profundidad) en  Millions of Colors+ 
(Millones de colores+).

 4. Haga clic en OK (Aceptar).

150



Configuración de ajustes de vídeo y sonido para películas de QuickTime

 1. En el cuadro de diálogo Movie Settings (Configuración de película), seleccione si desea que la película 
incluya datos de Video (Vídeo) y Sound (Sonido), y si el vídeo debe optimizarse para el streaming de 
Internet.

Parámetro Descripción

Video (Vídeo)

Habilita la exportación de datos de vídeo al archivo de película.

Settings (Configuración): Abre el cuadro de diálogo Standard 
Video Compression Settings (Configuración de compresión de 
vídeo estándar).

Filter (Filtro): Abre el cuadro de diálogo Choose Video Filter 
(Elegir filtro de vídeo), en el que puede seleccionar distintos filtros 
para aplicarlos a la exportación de vídeo.

Size (Tamaño): Abre el cuadro de diálogo Export Size Settings 
(Exportar configuración de tamaño). La configuración de tamaño 
se sobrescribe con la configuración de escena de Harmony.

Sound (Sonido)

Habilita la exportación de datos de sonido al archivo de película.

Settings (Configuración): Abre el cuadro de diálogo Sound 
Settings (Configuración de sonido) (ver a continuación).

Prepare for Internet Streaming 
(Preparar para streaming de 
Internet)

Habilita la optimización para el streaming en Internet.

Settings (Configuración): Abre el cuadro de diálogo Hint Importer 
Settings (Configuración del importador de sugerencias) si está 
seleccionada la opción Hinted Streaming (Streaming por 
sugerencias).
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 2. En la sección Video (Vídeo), haga clic en Settings (Configuración).

Se abre el cuadro de diálogo Standard Video Compression Settings (Configuración de compresión 
de vídeo estándar).

 3. En el menú Compression Type (Tipo de compresión), seleccione un códec. La disponibilidad de una 
configuración de compresión determinada depende del tipo de compresión seleccionado. Por 
ejemplo, cuando el tipo de compresión de la animación está seleccionado, la opción Data Rate (Tasa 
de datos) está atenuada.

NOTA

Si desea renderizar una película de QuickTime con compresión y transparencia sin 
pérdidas, puede utilizar el códec de vídeo de animación con la profundidad de color 
establecida en Millions of Colours + (Millones de colores +).

 4. En la sección Motion (Movimiento), seleccione un valor de Frame Rate (Fotogramas por segundo) de 
la lista.

Está establecida de forma predeterminada para coincidir con los fotogramas por segundo (fps) del 
proyecto de Harmony. Si selecciona un número de fotogramas por segundo inferior, la reproducción 
de exportación será más rápida que el proyecto real. Lo contrario también es cierto para un número 
de fotogramas por segundo superior.

 5. Si desea insertar fotogramas clave, seleccione la opción Every (Cada) y establezca el número por 
fotograma.
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Esta es la opción recomendada por QuickTime. Para obtener más información, consulte la 
documentación de QuickTime.

 6. En la sección Quality (Calidad), utilice el control deslizante para seleccionar una configuración de 
calidad. Recuerde que cuanto mejor es la calidad de la exportación, mayor es el archivo.

 7. En la sección Data Rate (Tasa de datos), seleccione permitir que el programa seleccione 
automáticamente la tasa de bits óptima, o bien introduzca una tasa restrictiva para ahorrar espacio y 
permitir una descarga más rápida sacrificando calidad de exportación.

 8. En la misma sección, en el menú Optimized For (Optimizado para), seleccione el método de 
visualización previsto para la exportación.

 9. Haga clic en OK (Aceptar).

 10. Desde el cuadro de diálogo Movie Settings (Configuración de película), haga clic en Sound Settings 
(Configuración de sonido).

Se abre el cuadro de diálogo Sound Settings (Configuración de sonido).

 11. En el menú Compressor (Compresor), seleccione un tipo de compresión. La configuración 
predeterminada es None (Ninguno). Exporta el audio como si no hubiera realizado ninguna 
compresión o conversión con pérdidas, conservando su fidelidad. Se pueden utilizar otros 
compresores si necesita que la pista de audio de la película se exporte en un formato específico o si el 
espacio en disco o la velocidad de descarga son críticos, pero pueden afectar de forma negativa a la 
calidad de la pista de sonido de la película.

 12. En el menú Rate (Tasa), seleccione una tasa. Lo mejor es exportar el audio a una tasa que coincida 
con la tasa de los archivos de sonido originales. Por ejemplo, si el archivo tiene una tasa de muestreo 
de sonido de 48 kHz y elige una tasa de conversión de 22,05 kHz, el sonido se reproducirá a la 
misma velocidad, pero faltarán las frecuencias más altas, haciendo que suene amortiguado. Como 
referencia, la calidad de sonido estándar es 44,1 kHz para películas y 48 kHz para DVD. Las tasas 
más bajas pueden afectar de forma negativa a la calidad de la pista de sonido de la película, pero 
pueden ser útiles si el espacio en disco o la velocidad de descarga son críticos.
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 13. Seleccione el tamaño de la codificación del audio en Size (Tamaño). También se conoce como 
profundidad de bits. Determina la cantidad de precisión utilizada para grabar cada longitud de onda 
en la pista de sonido. El tamaño estándar es 16 bits. Si elige 8 bits, la cantidad de espacio en disco 
que requiere la pista de sonido se reduce a la mitad, pero el sonido sonará amortiguado.

 14. En Use (Utilizar), seleccione si desea utilizar el modo de canal Mono o Stereo (Estéreo). El sonido 
estéreo tiene una pista de sonido independiente para los altavoces izquierdo y derecho, lo que 
permite que el origen de cada sonido coincida de forma real con el origen de su acción 
correspondiente. Si selecciona Mono, la pista de sonido puede utilizar menos espacio en disco, pero 
los canales izquierdo y derecho se combinarán en una sola pista.

Configuración de ajustes de vídeo y sonido para Windows Media Video

 1. En la sección Video (Vídeo), seleccione la calidad deseada para el vídeo en Variable Bit Rate Quality 
(Calidad de tasa de bits variable). Un ajuste más alto garantizará una mejor calidad de imagen. Un 
ajuste más bajo creará un archivo vídeo más pequeño.

 2. Utilizando la casilla de verificación Sound (Sonido), seleccione si desea que su archivo de película 
tenga sonido o no.

 3. Utilizando el menú desplegable Profile (Perfil), seleccione los ajustes de compresión preferidos para 
la pista de sonido de la película. Cada perfil tiene una combinación de tasa de muestreo de sonido, 
tamaño de muestreo y modo de canal, que cubren las siguientes opciones:

 l Tasa de muestreo: Las tasas de muestreo disponibles son 8000 Hz, 16 000 Hz, 22 050 Hz y 
44 100 Hz. La configuración predeterminada es 22 050 Hz. Lo mejor es exportar el audio a 
una tasa que coincida con la tasa de los archivos de sonido originales. Por ejemplo, si el 
archivo tiene una tasa de muestreo de sonido de 48 000 Hz y elige una tasa de muestreo de 
22 050 Hz, el sonido se reproducirá a la misma velocidad, pero faltarán las frecuencias más 
altas, haciendo que suene amortiguado. Como referencia, la calidad de sonido estándar es 
44 000 kHz para películas y 48 000 kHz para DVD. Las tasas más bajas pueden afectar de 
forma negativa a la calidad de la pista de sonido de la película, pero pueden ser útiles si el 
espacio en disco o la velocidad de descarga son críticos.

 l Tamaño de la muestra: También se conoce como profundidad de bits. Determina la cantidad 
de precisión utilizada para grabar cada longitud de onda en la pista de sonido. El tamaño 
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estándar es 16 bits. Si elige 8 bits, la cantidad de espacio en disco que requiere la pista de 
sonido se reduce a la mitad, pero el sonido sonará amortiguado.

NOTA

La exportación en sonido de 8 bits solo es posible con QuickTime instalado.

 l Modo de canal: El sonido estéreo tiene una pista de sonido independiente para los altavoces 
izquierdo y derecho, lo que permite que el origen de cada sonido coincida de forma real con el 
origen de su acción correspondiente. Si selecciona Mono, la pista de sonido puede utilizar 
menos espacio en disco, pero los canales izquierdo y derecho se combinarán en una sola pista.
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Glosario
3D estereoscópico                         Capacidad de crear imágenes estéreo que, cuando se animan y se ven a través de gafas con 

obturador activo 3D o mediante gafas con una lente roja y otra azul, se mostrarán como una 
película tridimensional.

canal alfa Canal de imagen que contiene información de transparencia. De partida, una imagen tiene 
tres canales: rojo, verde y azul (RGB). El canal alfa es el cuarto canal (A). El mate, o 
información de transparencia, se almacena en este cuarto canal. Una imagen sin canal alfa 
siempre es opaca.

animática                         Película con sonido que se desarrolla a partir del storyboard. El panel de storyboard queda 
expuesto durante el transcurso de la escena y, en ocasiones, los personajes se colocan en 
una trayectoria para indicar movimiento. Los movimientos de cámara también están 
animados. La animática se utiliza para determinar el ritmo de un proyecto y proporciona una 
buena visión general del proyecto antes de comenzar la producción.

animación Simulación de movimiento creada mostrando una serie de imágenes o fotogramas.

anime Estilo de animación conocido por su aspecto siniestro y oscuro, popular en Japón.

arco                         La acción no suele producirse de forma directa, sino que más bien se suele desplegar en lo 
que los narradores denominan un arco. El propósito de un arco de historia es mover un 
personaje o situación de un estado o escenario al siguiente.

proporción Relación entre las dimensiones de anchura y altura de una escena, fotograma o formato de 
película. La proporción en televisión es de 4:3 y la proporción panorámica de 16:9.

alimentador de papel 
automático 

Método automatizado de introducir dibujos en un escáner en el que hay varios dibujos 
apilados en un alimentador de hojas. Cuando se activa el escáner, los dibujos se digitalizan 
de forma consecutiva, sin ninguna otra intervención del usuario.

detección automática de 
sincronización de labios 

Asignación automática de dibujos en un elemento a la carta de fonemas generada para un 
sonido. Puede ahorrar tiempo al sincronizar los labios una pista de voz.

eje Línea imaginaria alrededor de la cual rota un objeto.

Para gráficos 2D, hay dos ejes: X (horizontal) e Y (vertical).

Para gráficos 3D, hay tres ejes: X (horizontal), Y (vertical) y Z (profundidad).

En animaciones que rotan constantemente, el elemento de eje especifica alrededor de qué eje 
rota el objeto. Un número negativo provoca que una animación rote en sentido contrario a las 
agujas del reloj, mientras que un número positivo hace que una animación rote a la derecha.

fondo                         Parte de una escena que está más alejada hacia la parte posterior. El fondo es la ilustración, o 
decoración, sobre la que se produce la animación.

curva Bézier Método para definir líneas curvas inventado por el matemático francés Pierre Bézier. Una 
curva Bézier es una curva matemática o paramétrica. Las curvas Bézier utilizan al menos tres 
puntos para definir una curva.

mapa de bits Imagen compuesta por píxeles con una única resolución (tamaño). Si se amplía demasiado, 
perderá definición y comenzarán a aparecer píxeles individuales. A esto se le conoce como 
pixelación.
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Los archivos de imagen de mapa de bits se definen como una malla rectangular estándar de 
píxeles individuales. Cada píxel individual contiene un valor que representa un color 
específico.

descomposición En animación Cut-out, la descomposición es la acción de descomponer un personaje en 
trozos para crear una marioneta con articulaciones. Para descomponer un personaje, el 
artista corta partes, como las manos y los brazos, del modelo del personaje y las pega en 
capas independientes. A continuación, las articulaciones se fijan y se definen los pivotes.

En la animación tradicional, una descomposición es una pose de animación que 
normalmente se encuentra entre dos poses clave. Las poses clave son las poses principales 
de una animación y las descomposiciones son poses secundarias que ayudan a describir el 
movimiento y la curva de rotación (normalmente denominada arco).

vibración de cámara La vibración de cámara se produce en una escena cuando la cámara se mueve ligeramente y 
rápidamente en varias direcciones. Este movimiento da la impresión de impacto, vibración o, 
por ejemplo, baches en la carretera.

cuadro de texto Campo de texto que contiene información de diálogo, efectos, sonido o slugging en un 
storyboard.

celda En la animación tradicional, una celda (también denominada celuloide) es una hoja 
transparente en la que la animación se tinta y se pinta antes de enviarla a la cámara. El 
trazado de la imagen se dibuja en la parte delantera de la celda y, a continuación, se colorea 
por la parte trasera.

diseño del personaje Cada personaje de una película animada se dibuja desde varios ángulos en formato de estilo 
póster denominado hoja de modelo, que sirve como referencia para los animadores.

aberración cromática                         En óptica, una aberración cromática (CA), acromatismo o distorsión cromática, es un tipo de 
distorsión en el que una lente no puede enfocar todos los colores en el mismo punto de 
convergencia.

clean up Una vez que los bocetos se han evaluado y aprobado, se quita todo el ruido de la imagen 
(líneas sobrantes, notas, etc.) para crear dibujos finales que se pueden tintar, pintar y filmar. 
El proceso de clean up hace referencia al trazado de una línea limpia sobre un boceto para 
conseguir la versión final o a la eliminación de la suciedad y las líneas adicionales que han 
quedado tras el proceso de digitalización.

CMYK Acrónimo en inglés de cian, magenta, amarillo y negro. Estos colores forman el modelo 
estándar utilizado en un proceso denominado impresión offset.

carta de color Una carta de color es una tarjeta que contiene un color sólido con el mismo tamaño que la 
cámara. La carta de color rellena el fondo con un color sólido cuando no se ha incluido 
ninguna imagen de fondo.

modelo de color Diseño de color oficial que se debe utilizar para pintar la animación. Un modelo es el diseño 
de personaje, prop o ubicación definitivo que cada artista debe seguir para la producción.

círculo cromático Visualización del espectro de colores en forma de círculo.

composición La composición es la acción de incorporar todos los elementos de una escena para crear el 
resultado final antes del renderizado. Por ejemplo, el artista de la composición importará 
todas las secuencias, el fondo, las superposiciones y las subcapas de la animación en la 
escena y los colocará correctamente. A continuación, el artista definirá el encuadre de cámara 
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y lo animará en caso necesario. Por último, el animador creará todos los efectos generados 
por ordenador para el proyecto.

fundido encadenado Efecto utilizado para fundir dos escenas, una dentro de la otra.

corte Transición directa entre dos escenas. Cuando se utiliza un corte, no se insertan efectos de 
transición para pasar de una escena a la siguiente. La primera escena termina y la segunda 
comienza inmediatamente.

animación Cut-out El proceso conocido como animación Cut-out es la acción de animar personajes compuestos 
por varias piezas moviéndolos de fotograma en fotograma. La animación Cut-out se puede 
generar por ordenador o realizarse del modo tradicional utilizando papel.

ciclo Grupo de imágenes que forman juntas una acción, como caminar. Un ciclo es una acción 
repetida como un bucle durante un período de tiempo. Puede ser una serie de dibujos o 
fotogramas clave animados.

diálogo Texto hablado por un personaje en una película o animación.

carta de rodaje La utilizan los animadores, directores y otros miembros del equipo para trazar la secuencia y 
el tiempo de las imágenes, el diálogo, los efectos de sonido, las pistas de sonido y los 
movimientos de cámara. Conocida también como carta de exposición.

usar carta de rodaje Asignar un dibujo determinado a un rango de fotogramas.

paso con doble bote En los fotogramas clave y las posiciones de paso de un paso con doble bote, el cuerpo es 
menor que una línea de referencia dibujada en posición vertical. Durante los intercalados, el 
cuerpo está situado sobre esta línea, ofreciendo así un aspecto de rebote.

DPI Siglas en inglés para puntos por pulgada, que representa la medida estándar de resolución 
para impresoras computerizadas. En ocasiones se aplica a pantallas, en cuyo caso es más 
exacto denominarlo píxeles por pulgada. En cualquier caso, el punto es el elemento 
diferenciado más pequeño que forma la imagen.

aceleración En animación, la velocidad es la aceleración y la desaceleración de un movimiento. Puede ser 
un movimiento creado mediante una curva de función o una serie de dibujos animados. 
Otros términos comunes para aceleración-gradual y desaceleración-gradual son aceleración 
y desaceleración.

aceleración-gradual Aceleración gradual en la acción. Conocida también como aceleración.

desaceleración-gradual Desaceleración gradual en la acción. Conocida también como desaceleración.

plano de situación Escena en la cual el espectador puede ver toda el área en la que se está produciendo una 
secuencia. Por ejemplo, si un niño está jugando en el patio delantero de su casa, el plano de 
situación sería una escena en la que el visor puede ver la casa, el patio, parte de la calle y los 
edificios situados alrededor del punto de acción central. Esto ayuda al espectador a entender 
la ubicación de la historia y la orientación de la escena.

exposición En animación, una exposición es el número de celdas en las que un dibujo aparece en la 
escena. Para que un dibujo parezca más grande, la exposición se debe ampliar durante un 
número de celdas mayor.

carta de exposición Hoja con varias columnas verticales y fotogramas horizontales que se utiliza para indicar el 
tiempo de una escena. Cada columna representa una capa de escena. Los números de 
dibujos de cada columna se indican y se repiten a lo largo de la cantidad de fotogramas 
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determinada en la que deben aparecer.

La carta de exposición la utilizan los animadores, directores y otros miembros del equipo para 
trazar la secuencia y el tiempo de las imágenes, el diálogo, los efectos de sonido, las pistas 
de sonido y los movimientos de cámara. Conocida también como carta de rodaje.

fundido de 
entrada/fundido de salida

El fundido de entrada o fundido de salida es un efecto de transición utilizado para abrir o 
cerrar una secuencia. Un fundido de entrada se produce cuando la primera escena aparece 
progresivamente, desde una transparencia total a su opacidad total. Un fundido de salida se 
produce cuando la escena desaparece progresivamente, desde la opacidad total a la 
transparencia total.

aceleración de entrada Aceleración drástica al principio de la acción.

aceleración de salida Aceleración drástica al final de la acción.

campo Unidad de medida utilizada para calcular el movimiento, el registro y la posición de la cámara. 
Una escena de animación estándar tendrá entre 6 y 12 campos.

hoja de campos Guía que contiene todas las unidades de campo que los artistas de animación y layout 
utilizan para determinar un tamaño de escena o movimiento de cámara.

film-1.33 Resolución idónea para el formato de película panorámico que se ajusta a la proporción 
estándar de 4:3 píxeles.

film-1.66 Resolución idónea para el formato de película panorámico que se ajusta a la proporción de 
16:9 píxeles. (Los píxeles son más anchos que altos).

flipping En la animación tradicional, flipping es la acción de pasar por los dibujos de una secuencia 
de animación muy rápidamente con el fin de ver la animación en movimiento. Flipping 
también puede ser la acción de crear una transformación en espejo de un objeto.

animación secundaria Movimiento secundario provocado por la acción principal. Por ejemplo, un personaje que 
corre y lleva puesta una capa. La acción principal es el cuerpo que corre. Esto provocará que 
la capa siga el movimiento, aunque no se moverá al mismo tiempo, sino que reaccionará 
varios fotogramas después y seguirá la curva de movimiento principal.

cinemática directa La cinemática directa es una función utilizada para animar principalmente personajes 3D y 
marionetas Cut-out con jerarquía. Se utiliza para animar una marioneta a partir de una de sus 
partes padres, como un hombro, y hacer que el resto del brazo se mueva con ella como un 
todo.

fotograma Un fotograma de animación es una imagen fotográfica única en una película. En la animación 
tradicional, el estándar norteamericano contiene generalmente 24 fotogramas por segundo, 
mientras que el estándar europeo es de 25.

fotogramas por segundo Representan la velocidad a la que se reproducen los fotogramas. Se calculan por lo general 
en fotogramas por segundo. Por ejemplo, una escena se podría reproducir a 12, 24, 25, 30 o 
60 fotogramas por segundo o a cualquier otro número.

Es la medida de la frecuencia (tasa) a la que un dispositivo de imagen produce imágenes 
consecutivas únicas, denominadas fotogramas. El término se aplica por igual a los gráficos 
por ordenador, videocámaras, cámaras de película y sistemas de captura de movimiento.

La tasa de fotogramas se suele expresar principalmente en fotogramas por segundo (fps) y 
en monitores de barrido progresivo en hercios (Hz).
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función Movimiento, trayectoria o ruta generados por ordenador al que se pueden conectar 
parámetros de elementos, otras trayectorias y efectos. La función se puede controlar 
agregando fotogramas clave y puntos de control en la curva de función.

gama Rango de colores que puede representar un dispositivo determinado.

HDTV Acrónimo en inglés de televisión de alta definición que ofrece una imagen de mayor calidad 
que la televisión estándar, ya que dispone de un número de líneas de resolución superior. 
Para sacar partido de la calidad superior y utilizar plenamente la configuración de resolución, 
el dispositivo de salida debe ser compatible con la tecnología HDTV.

hold                         Fotograma en la animación en el cual el personaje mantiene su posición sin moverse. Se 
puede crear un hold entre dos fotogramas clave cualesquiera.

HSV Siglas en inglés para matiz, saturación y valor. Método para definir los colores en cuanto a 
matiz (tinte), saturación (sombra) y valor (tono o luminancia).

intercalado Dibujos que existen entre las poses clave. Se dibujan para crear transiciones fluidas entre 
poses.

ink and paint El proceso ink and paint es la acción de pintar las zonas vacías y colorear las líneas en los 
dibujos de animación finales siguiendo un modelo de color.

interpolación Movimiento generado por ordenador creado entre dos fotogramas clave. Se puede crear 
interpolación, o no, entre los fotogramas clave.

cinemática inversa (IK)                         Función utilizada principalmente para animar personajes 3D y marionetas Cut-out con 
jerarquía. La cinemática inversa animará una marioneta desde una de las extremidades, como 
una mano, y permitirá que el resto del cuerpo la siga con naturalidad.

corte de salto Corte brusco entre dos escenas. Normalmente, un corte de salto no es visualmente 
agradable. Normalmente lo provoca el final de una escena y el comienzo de otra, con una 
imagen parecida. La falta de diferencia provoca que el ojo vea un pequeño salto entre las dos 
escenas.

pose clave Posiciones importantes en la acción que definen los puntos inicial y final de cualquier 
transición suave. Las claves, o poses clave, son los dibujos principales de una secuencia de 
animación que describen el movimiento. Por ejemplo, si se agita un brazo, las claves 
corresponderán al brazo de una extremidad del movimiento de onda y a la otra extremidad. Al 
realizar un flipping de dichos dibujos, el animador puede ver el esqueleto del movimiento sin 
tener todos los dibujos.

atajos de  teclado Una o varias teclas del teclado que, al usarlas, provocan que se realice una operación.

fotograma clave                         Posiciones importantes en la acción que definen los puntos inicial y final de cualquier acción. 
Un fotograma clave es una posición generada por ordenador en un momento específico 
(fotograma) y en una trayectoria determinada.

capa En animación, una capa es una columna, nivel o personaje individual. Las capas de una 
escena están superpuestas para formar la imagen final.

layout Paso de comunicación entre el storyboard y la animación. Es la acción de poner el storyboard 
en el modelo. Es decir, el personaje se dibuja siguiendo el diseño del paquete de modelo, de 
modo que el animador puede comenzar a trabajar.

El artista de layout dibuja el fondo y crea la cámara y la guía de campo, haciendo coincidir la 
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escena y el movimiento de la cámara. Por último, el animador dibuja en el modelo las poses 
de acción principales.

layout y pose Acción que consiste en poner el storyboard en el modelo (a la escala adecuada) para que el 
animador comience a trabajar.

artista de layout                         Artista que dibuja el fondo y crea la cámara y la guía de campo, haciendo coincidir la escena y 
el movimiento de la cámara. Dibujará en el modelo las poses de acción principales.

planificación de layout                         Dibujo de las funciones principales de la escena que se utiliza como referencia al planificar la 
animación y ejecutar sus etapas iniciales.

proceso de layout                         Paso de comunicación entre el storyboard y la animación.

librería Zona de almacenamiento que contiene plantillas y recursos que se pueden reutilizar en un 
proyecto o escena.

mesa de luz Dispositivo que permite ver otras capas en transparencia mientras trabaja en una capa 
determinada.

línea de acción                         Dirección que seguirá la acción. Conocida también como línea de acción.

sincronización de labios Proceso que consiste en sincronizar la boca de un personaje con sonidos en la pista de 
sonido del diálogo. La boca se ajusta fotograma a fotograma para hacer coincidir el sonido 
del diálogo y aparentar que el personaje está hablando. La sincronización de labios se puede 
utilizar para cualquier secuencia de sonido y no solo para el habla. Por ejemplo, puede hacer 
que un pájaro píe o que un lobo aúlle a la luna.

baja resolución Formato idóneo para vídeos destinados a la web, donde el tamaño y la descarga rápida del 
archivo de vídeo tienen prioridad respecto a la calidad. Una imagen de baja resolución es 
aquella que no contiene detalles precisos.

detección manual de 
sincronización de labios

Intercambio manual de dibujos de posición de la boca para que coincidan con una pista de 
voz. Para este proceso, se utilizan tanto la depuración de sonido (escuchar una onda de 
sonido descompuesta fotograma a fotograma) como las sustituciones de dibujos.

paleta maestra                         Grupo de colores atribuidos a un personaje o prop. La paleta se utiliza durante toda la 
producción para mantener la coherencia en el aspecto y para garantizar que se utilicen los 
mismos colores durante la producción. Conocida también como paleta.

modelo/modelo de color                         Diseño de personaje, prop o ubicación definitivo que cada artista debe seguir para una 
producción. Un modelo de color es el diseño de color oficial que se debe utilizar para pintar 
la animación.

morphing                         Función que permite crear dibujos generados por ordenador entre un dibujo de origen y otro 
de destino. La animación creada con la función de morphing se puede reutilizar en distintos 
proyectos.

fotograma clave de 
movimiento                         

Fotograma clave con interpolación generada por ordenador.

carta de fonemas                         Carta basada en los ocho fonemas de la animación (A, B, C, D, E, F, G y X, que se utiliza para 
representar el silencio) utilizados para la sincronización de labios.

multiplano Efecto de pasar por diversos niveles de dibujos para crear una sensación de profundidad en 
un plano. Un multiplano es una escena en la que las capas están colocadas a distintas 
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distancias de la cámara, de modo que, cuando la cámara se mueve, se produce una ilusión de 
profundidad. Con un multiplano, toda la perspectiva y la escala se calculan automáticamente.

NTSC                         Sistema de difusión televisiva analógico estándar utilizado en Norteamérica. NTSC se ciñe a 
los estándares norteamericanos respecto al modo en que los píxeles rectangulares se 
muestran para las pantallas de ordenador y de televisión.

desplazamiento pequeño Pequeño empujón (izquierda, derecha, arriba, abajo, hacia delante o hacia atrás) realizado 
con las teclas de flecha del teclado en un elemento seleccionado. El desplazamiento pequeño 
se utiliza para mover una selección de manera muy ligera y precisa.

papel cebolla Función que permite ver los dibujos anterior y siguiente de una secuencia.

capa superior Parte del entorno de una escena, como una silla o un arbusto, que se coloca delante de la 
animación principal.

PAL Resolución que funciona mejor con el formato europeo para pantallas de televisión y de 
ordenador, ya que los píxeles rectangulares se muestran con una orientación distinta.

paleta/paleta maestra                         Una paleta o paleta maestra es un grupo de colores atribuidos a un personaje o prop. La 
paleta se utiliza durante todo el proyecto para mantener la coherencia en el aspecto y para 
evitar cambios de color durante la animación. También se le denomina paleta maestra.

estilo de paleta                         Un estilo de paleta es una segunda versión de una paleta existente con un ligero cambio en el 
tinte y el valor. Un estilo de paleta se puede utilizar para crear la versión nocturna de una 
paleta. También se le puede denominar paleta de clonado.

panear Mover la cámara atravesando la escena en cualquier dirección.

panel                         En un storyboard, un panel es un fotograma en un plano. Un plano puede estar compuesto 
por uno o varios paneles.

animación sin 
papel/tradigital                         

El proceso de animación sin papel es la acción de animar digitalmente. El principal proceso 
de animación sin papel es dibujar la animación, fotograma a fotograma, directamente en el 
software.

posición de paso Al dibujar una secuencia en la que un personaje camina, la posición de paso es el punto en el 
que una pierna pasa a la otra.

línea de acción Dirección que seguirá la acción. Conocida también como línea de acción.

peg En la animación tradicional, es una herramienta utilizada para garantizar el registro preciso de 
la acción a medida que se mueven las capas de celdas. En la animación digital, en la que se 
realiza un rigging de marionetas más avanzado, se pueden usar capas de pegs. Las capas de 
pegs son capas de trayectoria que no contienen dibujos. Son rutas de movimiento que puede 
usar para agregar articulaciones de ruta. Para las últimas, también puede utilizar una 
herramienta de cinemática inversa.

fonema                          Unidad de sonido de un idioma.

pivote Punto alrededor del cual un peg o dibujo rota.

píxel Elemento más pequeño de una imagen mostrado en un monitor o pantalla de televisión.

El píxel, abreviatura en inglés de elemento de imagen, es un punto único en una imagen 
gráfica. Es una pequeña muestra de una imagen, un punto, un cuadrado o una sección muy 
pequeña compuesta de filtrado suavizado. Si acerca el zoom lo suficiente en una imagen 
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digital, verá los píxeles, que parecen pequeños cuadrados de distintos colores e intensidad.

animación pose a pose                         El proceso de animación pose a pose es la acción que consiste en crear todas las poses de 
acción principales, denominadas poses clave, y después colocar las poses secundarias entre 
las claves. Las poses secundarias se denominan descomposiciones. Por último, el animador 
rellena los huecos con los dibujos intercalados para lograr una animación fluida.

renderizado                          Paso final de la animación por ordenador. Durante el renderizado, el ordenador toma cada 
píxel que aparece en la pantalla y procesa todos los componentes. Además, agrega 
desenfoque de movimiento antes de que produzca una imagen final. Es el proceso de 
calcular las imágenes finales después del proceso de composición.

resolución                         Tamaño de una escena, calculado por lo general en píxeles. Por ejemplo, la resolución NTSC 
es de 720 x 480. La resolución debe coincidir con la salida final: HDTV, film-1.33, film-1.66, 
NTSC, PAL, baja.

RGB                         Siglas en inglés para rojo, verde y azul. Método que permite definir el color especificando las 
cantidades de estos tres componentes del color.

rigging Proceso de conectar las distintas partes de una marioneta Cut-out.

mesa de disco Equivalente al disco/mesa de animación, es un dispositivo que permite rotar el espacio de 
trabajo para mayor comodidad mientras se dibuja.

rotoscopia Técnica de animación en la que los animadores trazan un movimiento de película de acción 
en vivo, fotograma a fotograma, para usarlo en películas animadas. Es el acto de esbozar 
sobre material de acción en vivo para crear una secuencia animada.

bocetos                          Es un nombre común en una película de animación para un dibujo que se utiliza como 
referencia, pero no forma parte de la imagen final. Un layout es un boceto.

Es el esbozo del esqueleto de una animación o diseño. Los bocetos consisten principalmente 
en líneas y formas esbozadas, pero también pueden contener detalles de diseño.

zona segura                         Zona central del fotograma de una escena que no quedará recortada por el fotograma de TV. 
Como un fotograma de TV corta un margen del tamaño del fotograma original, al mantener 
una zona segura se garantiza que la acción principal de la escena siga siendo claramente 
visible una vez que la película se proyecte en televisión.

escena Plano en una película o programa. Una secuencia está compuesta por varias escenas. Una 
escena cambia a otra mediante un corte simple o por transición.

guion Texto original que contiene la información de toda la película o el programa. En animación, el 
guion contiene todas las descripciones de la ubicación, el diálogo, el tiempo, etc. Un 
proyecto comienza con un guion.

secuencia                          Serie de escenas o planos que forman una parte distinta de la historia o película, 
normalmente conectada por la unión de la ubicación o el tiempo.

plano                          Escena en una película o programa. Una secuencia está compuesta por varios planos. Un 
plano cambia a otro mediante un corte simple o por transición.

aceleración Aceleración gradual en la acción. Conocida también como aceleración-gradual.

desaceleración Desaceleración gradual en la acción. Conocida también como desaceleración-gradual.

slugging Indicación de los tiempos de inicio y detención de un diálogo y las acciones relevantes.
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depuración de sonido Proceso que permite escuchar el sonido en tiempo real, mientras mueve el cabezal de 
reproducción hacia delante o hacia atrás. Es muy útil para realizar el ajuste preciso de una 
sincronización de labios.

fotograma clave de Stop-
motion 

Fotograma clave sin interpolación generada por ordenador.

storyboard Plan visual de todas las escenas y planos de una animación. El storyboard indica lo que 
sucederá, cuándo lo hará y cómo se distribuyen los objetos en una escena.

animación directa                         Técnica en la cual se dibuja por orden una secuencia completa desde la primera posición 
hasta la última. Esta metodología requiere muy poca planificación. El lugar en el que el 
personaje termina y cómo llega hasta allí pueden ser una sorpresa tanto para el público como 
para el animador. Este enfoque es espontáneo y creativo, pero puede generar resultados 
imprecisos.

líneas vectoriales 
transparentes

Líneas vectoriales invisibles que forman las zonas de dibujo. Se pueden ajustar mediante 
controladores de curvas Bézier.

símbolo                         Un icono combina animación, ilustración o capas en un único objeto que puede controlar en 
una capa. También puede crear iconos de cada parte del cuerpo en marionetas Cut-out.

En un icono puede colocar lo que desee. Puede utilizar símbolos para animar una marioneta 
o crear animaciones reutilizables, como un parpadeo.

tableta/lápiz Dispositivo utilizado junto con un ratón, o en lugar del mismo, para mover el puntero (en 
ocasiones denominado cursor) por la pantalla del ordenador.

plantilla                          Recurso almacenado en la librería que se puede reutilizar en cualquier proyecto. Una plantilla 
puede ser un dibujo, una serie de fotogramas clave, un archivo de sonido, un panel, un 
personaje Cut-out, un efecto, una trayectoria, una animación o cualquier otra cosa que se 
utilice en la animación.

imagen miniatura Imagen muy pequeña utilizada como una referencia o indicador.

código de tiempo                          Información de tiempo impresa en un clip de película para indicar la escena, hora, minuto y 
segundo que se muestran actualmente en pantalla.

línea de tiempo Representación horizontal de los elementos, el tiempo y los fotogramas clave de una escena.

trazar y pintar                         Una vez que los bocetos de las animaciones se han limpiado y se ha realizado una prueba de 
línea o de lápiz final, cada dibujo se traza y se pinta para la animación final. En el mundo 
digital actual, esto se puede realizar de maneras distintas a los métodos de celuloide o 
acetato tradicionales.

desglose de pista de 
audio 

Desglose de una pista de película animada en sonidos individuales para generar la posición 
fotograma a fotograma precisa de cada sonido.

animación tradicional Tipo de proceso de animación mediante el cual todas las secuencias de animación se dibujan 
a mano en papel antes de digitalizarlos o tintarlos en celdas.

trayectoria                          Ruta o trayectoria generada por ordenador que pueden seguir los elementos. La trayectoria se 
puede controlar mediante puntos de control, fotogramas clave y velocidad.

transición                          Efecto colocado entre dos escenas cuando se pasa de una a otra. Efectos de transición 
comunes son el fundido encadenado y el barrido.
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capa de fondo                         En animación, una capa de fondo es una parte específica de la decoración colocada detrás de 
la animación principal.

vector Una imagen basada en vectores está compuesta por puntos y curvas Bézier. El ordenador lee 
los puntos y traza los segmentos, vinculándolos para reproducir la forma de imagen. Una 
imagen vectorial no contiene tamaño fijo ni resolución. El gráfico se puede ampliar y 
distorsionar según se desee y el sistema volverá a calcular los segmentos y reconstruirá las 
formas. Las imágenes vectoriales se trasladan y se muestran en píxeles una vez que el cálculo 
se ha realizado.

velocidad En animación, la velocidad es la aceleración o la desaceleración de un movimiento. Se puede 
alcanzar mediante una curva de función o una serie de dibujos animados. Otros términos 
comunes para aceleración-gradual y desaceleración-gradual son aceleración y 
desaceleración.

ciclo de andar                          Animación que representa a un personaje mientras camina en su posición. La ilusión de 
movimiento se crea utilizando paneos de fondo. A fin de evitar animar a un personaje que 
camine una y otra vez en cada episodio de una serie, es habitual preparar ciclos de andar para 
cada personaje en una producción, de modo que se pueden reutilizar según sea necesario.

zona                          Área que se puede pintar con color.
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